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Introduction 

Word 2003 is a powerful word processing application that allows users to produce typed 
documents.  These can range from simple letters through to fax cover sheets, reference 
manuals and sophisticated reports incorporating numbered headings, figures and graphics. 

How to use this guide 

This manual should be used as a point of reference following attendance of a Word 2003 
training course.  It covers all the topics taught and aims to act as a support aid for any 
tasks carried out by the user after the course. 

The manual is divided into sections, each covering an aspect of the course.  The table of 
contents lists the page numbers of each section and the table of figures indicates the pages 
containing tables and diagrams.   

Objectives 
Sections begin with a list of objectives each with its own check box so that you can mark 
off those topics that you are familiar with following the training. 

Instructions 
Those who have already used a word processor before may not need to read explanations 
on what each command does, but would rather skip straight to the instructions to find out 
how to do it.   Look out for the hand icon which precedes a list of instructions.  

Appendices 
The Appendices list the toolbars mentioned within the manual with a breakdown of their 
functions and tables of shortcut keys. 

Keyboard 
Keys are referred to throughout the manual in the following way: 

[ENTER] – denotes the return or enter key, [DELETE] – denotes the Delete key and so 
on. 

Where a command requires two keys to be pressed, the manual displays this as follows: 

[CTRL][P] – this means press the letter “p” while holding down the Control key. 

Commands 
When a command is referred to in the manual, the following distinctions have been made: 

When menu commands are referred to, the manual will refer you to the menu bar  –  
E.g. “Choose File from the menu bar and then Print”. 
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When dialog box options are referred to, the following style has been used for the 
text – “In the Page Range section of the Print dialog, click the Current Page option” 

Dialog box buttons are shaded and boxed – “Click OK to close the Print dialog and 
launch the print.” 

Notes 
Within each section, any items that need further explanation or extra attention devoted to 
them are denoted by shading.  For example: 

 

Note: “Word will not let you close a document that you haven’t already 
saved changes to without prompting you to save.” 
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Section 1  

The Basics 

Objectives: 
By the end of this section you will be able to: 

 Understand and use the common elements 
of a Windows program 

 Launch Word 

 Understand the Word screen 

 Use Toolbars 

 Use Menus 

 Get Help 
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Windows Concepts 

Word is an application that runs under the Windows graphical user interface.  When 
launched, Word sits in its own “window” – the blue box that surrounds the application 
elements.  The window can be moved, sized, closed, minimised and maximised using the 
features common to the Windows environment which are listed below:  

 
Figure 1 – Window elements 

 
Window Border The grey box that surrounds the Word screen when it is not 

maximised is called the window border.  When the mouse is over 
the border, the pointer changes from a single to a double-headed 
arrow. Clicking and dragging with this mouse pointer allows the 
window to be resized. 

Title bar  The coloured bar that appears at the top of the Word window is 
called the Title Bar. The Title Bar tells you which application you 
are using and if the document you are in is maximised, it will also 
contain the name of the document.  If the Word window is not 
maximised, by positioning the mouse over the title bar and 
clicking and dragging, you can move the Word window to a new 
location on the screen. 

Standard 
Toolbar 

Formatting 
toolbar 

Task Pane 

Status Bar 
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Maximise button When working on a document, the Word screen contains two 

windows, an application window and a document window.  You 
can maximise both windows to use all the available space you 
have on-screen. If you would like the Word application window to 
fill up the whole screen, click the outermost maximise button.  
You may find that the document you are in could still be bigger – 
click the inner maximise button to fill the remaining space within 
the Word application window. 

Minimise button This button is very useful if you need to temporarily switch from 
Word into another application without closing Word down 
completely. By clicking the minimise button to shrink Word to an 
icon on the task bar, you will be able to view other icons on your 
desktop for additional applications you may wish to access. When 
you are finished and ready to continue word processing, click the 
Word icon from the task bar to resume.  Note that the innermost 
minimise button will minimise the current document window 
rather than the application window. 

Restore button This button only appears when a window is maximised.  A 
maximised window has no border and you can’t see what is 
behind it.  If you want to put the window back inside its border so 
that you can move and size it, click the restore button. 

Close button This button is used to close a window.  If you click the close 
button for a document window (the innermost close button), you 
close the document, the outermost button will close the Word 
application. 

Application Menu The application menu icon is located to the left of the Title Bar.  
When selected, it displays a pull-down menu with commands 
enabling you to resize or close the Word application.  This can 
also be accessed by pressing [ALT][SPACEBAR]. 

Note: Double click on this icon to close the application down. 
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Getting Started  

Word 2003 is a windows based application and is therefore launched the same way as 
other applications.   

 

 To Launch Word: 
 

• Click on the Start button 

• Move up to Programs 

• Across to select Microsoft Word  

 

Or alternatively, a shortcut can be created and placed on the desktop to start 
Word. 

 

• From the windows desktop, double-click on the Microsoft Word 
icon. 



Word 2002 Essentials 

The Basics 

http://www.mousetraining.co.uk Page7 © The Mouse Training Company 
   

Screen Layout 

The diagram below indicates the elements visible on the Word screen.  Toolbar buttons 
all come equipped with screen tips which give extra information about the button’s 
function when the mouse is hovered over it.  The View selector buttons at the bottom left 
of the screen also have this feature.  

 

 

 
 

Title bar  

The Title Bar appears at the top of the Word window, registering the title of the 
application and the document you are working on. If the Word window is not maximised, 
by positioning the mouse over the title bar and clicking and dragging, you can move the 
Word window to a new location on the screen. 

Menus 
The menu bar contains menus giving access to all the commands that can be carried out in 
Word. There are two methods for accessing menus and their options - the menu bar and 
the shortcut menu.  

Title Bar 
Menu Bar Toolbars 

Task Pane 

Document 
Work Area 

Status Bar 
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Menu Bar 
The menu bar displays all options available within Word.  You can access a menu by 
clicking its name with the left mouse button.  

 To select a menu bar menu: 
Mouse 
• Click on the menu title.  A pull-down menu will appear listing all 

options available. To reveal the 
rest of the menu click on the 
arrows at the bottom of the 
menu.   

• Click the required menu option. 

Or 
Keyboard 
• Hold down the [ALT] key and press the underlined letter of the 

menu title. 

• Type the underlined character of the required option within the 
menu. 

Shortcut menus 
Shortcut menus can only be accessed when the mouse is positioned over a piece of text in 
the document, by clicking the right mouse button.  The options that appear on the shortcut 
menus are context sensitive and may differ depending on what you have selected. 

 

 To select a shortcut menu option: 
Mouse 
• Click with the right mouse button over an item in your document. 

A menu will appear listing options available. 

 

• Click the required menu option. 

Figure 2 - Shortcut Menu 
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Toolbars 

Word has many different toolbars that can be displayed on the screen but the default 
toolbars are the Standard toolbar and the Formatting toolbar. 

The Standard toolbar contains buttons for commonly carried out operations such as 
opening a file, saving a file and copying information. The Formatting toolbar buttons are 
devoted to enhancing the appearance of text in a document.  When you hover 
your mouse over any toolbar button, Word will display a description of what 
the button does.  

Show and hide toolbars 
In addition to the Standard and Formatting toolbars, there are other toolbars in Word 
which give you access to buttons that relate to specific tasks, such as Drawing. These 
additional toolbars can be turned on or off at any time. 

 

 To show an additional toolbar: 
Mouse 
• Click the right mouse button anywhere over a 

displayed toolbar. 

• From the shortcut menu, click the toolbar you 
want to show. 

 To hide a toolbar: 
Mouse 
• Click the right mouse button anywhere over a 

displayed toolbar. 

• The resulting menu will indicate the toolbars 
currently displayed. These are marked with a tick 
symbol. Click the toolbar you want to hide. 

 
Figure 3 - Toolbars List 
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Horizontal and Vertical Ruler 

Horizontal and vertical rulers are displayed on the left and across the top of the document 
window. 

 

You can use the horizontal ruler to view and set paragraph indents, tab stops, page 
margins and column widths. 

In Print Preview and Print Layout view, Word also displays a vertical ruler you can use to 
adjust top and bottom page margins and row height in tables. 

 

 To show or hide the horizontal ruler: 
Mouse 
• From the View menu, select Ruler. 

 

Status Bar 

The status bar is a horizontal area in Word below the document window. It provides 
information about the current page and positioning of the cursor and additional contextual 
information.  

 

Information on the Status bar reading from left to right tells you: 

 

• The page you are currently positioned on 

• The section you are currently positioned in 

• The total number of pages 

• The cursor position in relation to the top edge of your page 

• The line position (horizontal) and the column position (vertical) of 
the cursor 
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 To show or hide the status bar: 
Mouse 
• From the Tools menu, select Options. 

• Select the View tab, and then select the Status bar check box. 

 

Scrollbars 

The Scrollbars are located along the right and bottom of the document window. They 
enable you to move to another part of the document by dragging the box or clicking the 
arrows in the scroll bar. 

Task Pane 

A task pane is a window that collects commonly used actions in one place. The task pane 
enables you to quickly create or modify a file, perform a search or view the clipboard. 

It is a Web-style area that you can  either dock along the right or left edge of the window 
or float anywhere on the screen. It displays information, commands and controls for 
choosing options. Like links on a Web page, the commands on a task pane are highlighted 
in blue text, they are underlined when you move the mouse pointer over them, and you 
run them with a single click.  

 
A task pane is displayed automatically when you perform certain tasks, for example when 
you choose File, New commands from the menu bar to create a new document. 

 

Figure 4 - Task Pane 
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 To display a task pane at any time: 
Mouse 
• Choose View, Task Pane from the menu bar. 

Or 
• Choose View, Toolbars, Task Pane from the menu bar. 

Or 
• Right-click the menu bar or any toolbar and choose Task pane 

from the shortcut menu. 
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You then need to navigate to the particular task pane you want to work with. You can 
display any of the task panes that are available by clicking the down arrow near the 
upper right corner of the pane that is displayed initially, and choosing the name of the 
pane you want to open from the drop-down menu. 

 

You can navigate among the task panes you have recently displayed by clicking the Back 
and Forward Web-style buttons. Close the task pane by using the close button. 

View Buttons 

Microsoft Word has different ways for you to view your work, depending on the task at 
hand. You can switch between those views at the bottom left corner of the Word screen. 

 

 

 
 

 

 

The views are covered in depth later in the manual. 

Figure 5 - Task Pane List 

Normal 

Web Layout 
View

Outline 
View

Reading 
Layout 

Print Layout 
View
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Figure 6 - Smart Tag 

Smart Tags 

Smart Tags make it easier for you to complete some of the most common tasks and 
provide you with more control over automatic features.  

 
You do not have to complete any additional steps to make the Smart Tags appear or 
disappear in Word. The Paste Options and AutoCorrect Options smart tags will appear 
automatically to allow you to quickly choose actions and remain in place until you begin 
another action. For example, when you complete a paste operation, the Paste Options 
smart tag remains in place alongside your text until you begin typing new text.  

 

 To turn off Smart Tags 
Menu 
• Choose Tools, AutoCorrect Options from the menu bar. 

• Select the Smart Tags tab.  

• Clear the Show Smart Tag Actions buttons check box.  

• Click OK.  

Note: Turning off any of the Smart Tag buttons will make that action 
unavailable across all the Office programs where it is an option e.g. if you 
turn off the AutoCorrect button in Word, the AutoCorrect button will also 
be turned off in PowerPoint. 

 

Browse Object  

You can scroll through a document more quickly by selecting 
Browse Object  on the vertical scroll bar. It enables you to go to a 
page, bookmark, footnote, table, comment, graphic, or other location 
by selecting the item you want.  

You can click Next    or Previous   to go to the next  or previous item of the same 
type. 
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Microsoft Word Help 

Word offers several quick ways to get help when performing particular tasks. You can 
select from a list of topics provided by Help, or you can even type a help request in plain 
English, and Word will supply the answer using the Answer Wizard.  

The Office Assistant 
In Word 2003, you can use the Assistant to get help quickly by typing plain English 
questions or phrases. 

 

 To use the Asistant: 
Mouse 
• Choose Help , Show the Office Assistant from the menu bar to 

turn the assistant  on if it has not been turned on. 

• When the Assistant is turned on, you can quickly display the 
Assistant and its balloon by choosing Help, Microsoft Word Help 
from the menu bar, by clicking the Help toolbar button, or by 
pressing F1 on the keyboard. 

Note: To hide the Office Assistant balloon, click the Assistant again. 

• Type a question or phrase and click the Search button. 

• Scroll through the topics, if necessary, by clicking on See More or 
See Previous, then click on the required topic. The help text will 
be displayed in the Help Window. 

Figure 7 - The Office  Assistant 

Figure 8 - The Assistant Balloon 
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Ask a Question Box 
Word 2003 provides a convenient new alternative to using the Office Assistant, the Ask a 
Question box. You can get help by typing a question or phrase into Ask a Question and 
pressing [ENTER]. You will find Ask a Question in the upper-right corner of the 
application window. 

 

 

If you want to repeat a question you have already typed during the current session, you 
can simply select the question from the drop-down list accessible via the down arrow on 
the Ask a Question box. 

 

Figure 9 - Ask a Question 

Figure 10 - Ask a Question List 
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The Help window 
The Help Window provides more options than either the Office Assistant or Ask a 
Question.  

 To access the Help Window: 
Mouse 
• Ensure that the Office Assistant is turned off and choose Help,  

Microsoft Word Help from the menu bar, or click the Help toolbar  

 button, or press F1. 

 

  

• Type the search help criteria in the Search area and choose the 
green arrow to start the search 

• Select a displayed result link to view the help file 
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Notes 
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Section 2 

Entering & Editing Information 

Objectives: 
By the end of this section you will be able to: 

 Enter information on the Word screen 

 Edit information 

 Start new documents and save files 

 Close and Open files 
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Entering and Editing Information 

When Word 2003 is launched at the beginning of a work session, it provides a blank 
document ready for you to start typing.  Word assigns the name “Document1” and this 
appears on the title bar at the top of the screen until you save the document and allocate a 
filename.  Each time a new document is created, Word will assign this temporary name 
with the number of the document going up in sequence (e.g. the second document created 
in any one session would be “Document2” and so on). 

The cursor appears as a flashing vertical bar. To enter text, simply begin to type. If your 
cursor is at the top of the page and you wish to type text some way down the page, double 
click with the mouse to anchor your cursor in the desired location. This feature is known 
as Click and Type.  

Word Wrap 

When you are typing in a document, Word has a feature called word wrap.  This is what 
makes the cursor automatically jump onto a new line when the text that you are typing 
has filled up all the space on the previous line.  Therefore the only time that you need to 
tell Word to begin a new line is if you want to start a new paragraph. 

Inserting Lines 

When typing, you can end the line you are on and begin a new line by pressing the 
[ENTER] or [RETURN] key on the keyboard.  This key can be also used to insert a blank 
line.  

 Splitting a paragraph: 
Keyboard 
• Position the cursor where you want to break the paragraph and 

press the [ENTER] key – the text to the right of the cursor will 
jump down to the next line.   

• You may want to insert another blank line between the two 
paragraphs – with the cursor positioned at the beginning of the 
second paragraph press the [ENTER] key again. 
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Editing Text 

Word provides two editing modes: Insert and Overtype. You can also delete the text you 
have already typed, undo or redo the changes. 

Insert & Overtype mode 
In Insert mode (the most common mode), any existing characters beyond the insertion 
point are moved ahead in the document as you type. In Overtype mode, the new 
characters you type replace the existing characters to the right of the insertion cursor.  

The status bar tells you which mode you are in by displaying OVR when Overtype mode 
is active.  Double-clicking on OVR or pressing [INSERT] on the keyboard switches 
between the two modes (i.e. if Overtype mode is on, double-click OVR on the status bar 
to switch it off). 

Typing replaces selection 
Overtype mode allows you to replace one set of characters with another, however, it can 
cause problems if you forget to switch it off, or if the number of characters you are 
replacing is different to the number of characters you are adding. 

By selecting the text you want to replace and then typing in the replacement text, you 
have more control over what is deleted.  For example, in the sentence below, you could 
change the word “previous” to the word “former” very easily by: 

 Double-clicking the word “previous” to select it. 

 Typing the word “former” 

“Previous performances have included…….” 

 

Note: Typing replacing selection is a very useful feature. However, it is 
sometimes easy to select a large area of text and then hit the [ENTER] or 
[RETURN] keys by accident. This will replace the whole of your selection 
with a paragraph return, effectively deleting the whole of your text. If this 
happens, clicking Undo (covered later in this section) will bring your 
selected text back. 

Deleting Text 
Even the most perfect touch typists occasionally make mistakes!  If you need to remove 
text or add in extra characters, there are a variety of ways to do it. 

There are two main keys that remove text from a document, the [DELETE] and 
[BACKSPACE] keys.  The [DELETE] key is easy to find as it generally has the word 
“Delete” or “Del” written on it.  The [BACKSPACE] key is situated immediately above 
the [ENTER] key and usually has a backwards ( ) arrow on it. 

The [DELETE] key removes a character in front of the cursor when you press it; the 
[BACKSPACE] key removes characters behind the cursor.  The key you use to remove 
characters depends therefore on where your cursor sits.  The examples below illustrate the 
use of both [DELETE] and [BACKSPACE]. 
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 To use Delete: 
Keyboard 
• “fee⏐eling” – with the cursor positioned in front of the extra “e”, 

use the [DELETE] key to remove it. 

 To use Backspace: 
Keyboard 
• “feee⏐ling” – with the cursor positioned behind the extra “e”, use 

the [BACKSPACE] key to remove it. 

Deleting Whole Words 
You can boost the power of the [DELETE] and [BACKSPACE] keys by holding down 
the Control key as you press them.  The Control key is the key marked [CTRL] and is 
generally situated in the bottom left-hand corner of the keyboard).  [CTRL] [DELETE] 
removes a whole word in front of the cursor and [CTRL] [BACKSPACE] deletes a whole 
word behind the cursor. 

 

 To remove whole words: 
Keyboard 
• “The course begins at 9 o’clock ⏐sharp” – with the cursor in front 

of the word “sharp”, use [CTRL] [DELETE] to delete it. 

• “The course begins at 9 o’clock sharp⏐” – with the cursor behind 
the word “sharp”, use [CTRL] [BACKSPACE] to delete it. 

Joining a paragraph 
To get rid of blank lines, you can use the [DELETE] and [BACKSPACE] keys as 
described earlier in this manual.   

 

 To join a paragraph: 
Mouse 
• Place the cursor in front or behind the blank line you want to 

remove and press either the [DELETE] or [BACKSPACE] key. 
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Show / Hide All 

You may find it easier to edit information if you click the Show/Hide button on the 
toolbar – , which displays non-printing characters such as spaces, carriage returns, tabs 
and hidden text.  The symbol for blank lines looks like a mirror-image of a capital “P”. 

 

The Undo feature 

With a selection made, typing new characters will replace that selection.  Obviously, this 
could cause problems for, if you accidentally touched a key with the whole document 
selected, you would replace all your text with the character that you pressed! 

If this happens, or indeed if you do anything in Word and then regret your action at a later 
stage, you have the option to undo it.  During any one work session, Word keeps track of 
at least 250 of the most recent commands you have issued, and allows you to go back to 
the version of the document before you carried them out. 

 

 To undo the most recent action: 
Mouse 

• Press the Undo button on the toolbar . 

Or 
Keyboard 
• Press [CTRL][Z]. 

 To undo several actions: 
Mouse  
• Click on the downward arrow that sits just to the 

right of the Undo button.  This will drop down a 
list of the commands issued during the current 
work session (the last six actions are displayed, 
but Word provides a scroll bar to get to earlier 
actions).   

• Click the action you wish to undo – you will 
notice that if you choose the sixth action in the 
list, Word undoes all commands from the sixth 
upwards. 
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Redo 
The Redo button becomes available as soon as you have undone an action.   

  To redo an action: 
Mouse 

• Click the Redo button  to redo the most recently undone 
command. 

Or 
Keyboard 
• Press [CTRL][Y]. 

Like the Undo button, you can click the downward arrow to the right of the Redo button 
to display a list of the most recently undone actions and redo them all. 

 

 To redo several actions:  
Mouse 
• Click on the downward arrow that sits just to 

the right of the Redo button.  This will drop 
down a list of the commands undone during 
the current work session (the last six actions 
are displayed, but Word provides a scroll bar 
to get to earlier actions).   

• Click on the earliest action to redo and the ones above will 
automatically be repeated. 

Note: If you simply want to repeat the last action, use [F4], Word’s 
repeat key. 
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Figure 12 - The Smart Tags tab 

Using Smart Tags 

Word can recognise a wide range of different data types entered into a document, such as 
names, dates, addresses and stock ticker symbols. It converts each recognised piece of 
data into a smart tag, and you can then use a menu attached to the smart tag to perform 
useful actions on that data. 

Before you start using smart tags, you need to check if smart tags are enabled and specific 
smart tag recognisers are also activated. 

 

 To enable smart tags:  
Mouse 
• Choose Tools, AutoCorrect Options from the menu bar. 

• In the AutoCorrect dialog box, click the Smart Tags tab.  

 

 

• Check the Label text with smart tags option to have Word 
recognise smart tags contained in a document. 

• Check the Show Smart Tag Actions buttons option to have 
Word display smart tag buttons. 
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• Activate the specific smart tag recognisers you want to use and 
click the OK button. 

Assuming that you have activated for example the person names recogniser, whenever 
you type a proper name into a document, Word will recognise the text as a name and will 
provide you with a Smart Tag. When you press Enter at the end of the paragraph 
containing the name you will see the name becomes underlined with dots. When you 
hover on the underlined name with your mouse, the Smart Tag button will be revealed. 

 

 To work with a smart tag:  
Mouse 
• Move the mouse pointer or insertion point over the smart 

tag. Word will display an information icon above and to 
the left of the text . 

• Move the pointer over the icon and the smart 
tag button appears.  

• Click the button and choose a command from the drop-down 
menu. 
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AutoCorrect 

Word has the ability to recognise commonly committed typing errors and correct them 
automatically.  For example “Teh” is corrected to “The” as soon as you press the space 
bar to begin the next word or press Enter to begin a new paragraph. 

Other automatic corrections include: 

• Capitalising the first word of a sentence 

• Correcting the accidental use of the [CAPS LOCK] key 

• Capitalising the names of days 

• Correct two initial capitals 

• Capitalising the first letter of table cells 

 

AutoCorrect Button 
Word 2003 also lets you modify an AutoCorrect correction using the AutoCorrect smart 
tag, which will appear after the autocorrection has been made. 

 

 To use an AutoCorrect button:  
Mouse 
• Move the mouse pointer or insertion point to the 

text AutoCorrect has modified. A bar will appear 
below to the left of the text indicating that an 
option is available.  

• Move the pointer over the bar and the AutoCorrect 
Options button will appear.  

• Click the button the and choose a command from 
the drop-down menu. 
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Auto Spell and Grammar Check 
Word 2003 will automatically flag spelling and grammatical errors as you type.  A wavy 
red line under the error indicates spelling mistakes, a wavy green line indicates 
grammatical errors.   

This feature is covered more fully in the section on Proofing Tools. 
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File Operations 
You can save any information entered in Word so that you may call it back at a later stage 
either to add, edit or print the contents.  It’s a good idea to save work frequently as this 
will minimise the risk of work being lost in the event of a power cut or system fault. 

The first three buttons on the standard toolbar carry out the most common file operations 
which are described in detail below. 

New Files  

 To create a new file: 
Mouse 

• Click  from the standard toolbar.  A blank document will 
appear on-screen ready for you to start entering information. 

Or 
Keyboard 
• [CTRL][N] will create a new file. 
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Templates 

All documents you create in Word are based on a specific template. When you create a 
new document using the New Blank Document button  or [CTRL][N], you are creating 
a document based on the Normal template. This is a blank template which provides only a 
few key pieces of information for your file such as margins being of a certain size, 
portrait page orientation and default text style, size and colour.  

 

The Normal template is a very good template to base most documents on. However, if 
you want to base a new document on a specific layout there are other Word templates you 
can access. These can be used to start you off with a layout for certain documents such as 
memos and faxes. You can access templates other than Normal in the following way: - 

 

 To choose a template: 
Mouse 
• Choose File, New from the Menu bar.  The 

New Document task pane will appear. 

• In the Templates section, select “On my 
computer” or another location listed. This will 
open the templates dialogue and allow you to 
select a template of choice 

Note: The General Templates area contains templates 
for common everyday documents like memos, letters 
and faxes. 

Or 
• Double click on the document icon. 

• The new document will appear ready for you to 
start typing. 

Figure 13 - New Document 
Task Pane 
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Saving files  

Word gives any new document you create a temporary name – the word “Document” 
followed by a number.  The number increases by one for each new document you create 
in any one work session.  

 

 To save a file: 
Mouse 

• Click the Save button . If you haven’t saved the document 
previously, the Save As dialog box will appear asking you for a 
document name and location. 

 

The first list box marked Save in allows you to determine the drive and folder that you 
want to save the document in.  The area below the Save in list allows you to see which 
files are stored in the area currently displayed. 

  To change the location: 
Mouse 
• Click the drop-down list arrow to the right of the Save in list box 

and choose the desired drive or folder. 

Note: If you choose a drive, you will see a list of folders within that drive 
inside the dialog box.  If the list is very long, Word provides you with a 
horizontal scroll bar to access folders that are not currently visible.  Once 
you can see your folder, you can double-click to open it. 

At the bottom of the dialog box are two list boxes, one for the file name and one for the 
document type.  Word automatically assigns the first few words you typed as the 
document name.   

Figure 14 - Save As Dialog 
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 Naming a file: 
Mouse 
• Click in the File name box and drag your mouse over the current 

file name – this will highlight it. 

• Type the new name. 

Note: Document names can be up to 255 characters. File names cannot 
include any of the following characters: forward slash (/), backslash (\), 
greater than sign (>), less than sign (<), asterisk (*), period (.), question 
mark (?), quotation mark ("), pipe symbol (|), colon (:), or semicolon (;).  
You don’t need to type the document extension (“.doc”) as Word 
automatically adds this to all files you save. 

• Finally, when the location and name have been entered, save the 
document by clicking the button marked Save.  This closes the 
dialog box.  Back in the Word screen you will notice that the 
name you allocated to your document appears on the title bar. 

Saving changes to files 
Once you have allocated a name to a file using the Save As dialog, clicking the Save  
button on the Standard toolbar simply saves any new changes to the filename you 
originally gave.  It is worth saving files that you are working on every ten minutes or so.  
When you click the Save button, the status bar displays a message to say that it is saving 
and a blue meter which counts up to show how long the save will take. However, if the 
file you are working on is relatively small or there aren’t many new changes to save, you 
may not see any message in the status bar as the save can happen very quickly. 

 

 To save changes to a file 
Mouse 

• Click on the Save  button  on the Standard toolbar.  

Or 
Keyboard 
• Press [CTRL][S].  

Note: If the document has never been saved before, the “Save As” dialog 
will appear, otherwise changes are saved to the file name that you have 
already allocated.. 
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Closing Files  

When you finish working on a file, you can close it down using the following methods: 

 

 To close the current file: 
Mouse 

• Double-click  (situated to the above - left of the File menu). 

Mote: You will see two of the Close buttons on-screen – one will close the 
current file and the other will close the Word application.  To close the 
current file, use the innermost close button.If you have changed a file since 
the last time you saved it, Word will not let you close that file without 
prompting you first to save the changes. 

  
Figure 15 - Save Prompt 

Close all files 

When you have  several files open, you can close them all by holding down the [SHIFT] 
key as you click File from the menu bar.  Choose the Close All option to close all 
currently open files. 
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Opening Files  

You can open a document on your computer hard disk or on a network drive that you 
have a connection to. 

 To open a file: 
Mouse 

• Click the open button .  The following dialog box will appear: 

Figure 16 - Open dialog 

• If the file you want isn’t listed in the window, click the Look in 
drop-down list box to change to the location of the desired 
document.   

• To open the file either: 

• Click once on the file name to select it and click the Open button. 

Or 
• Double-click the file name. 

Keyboard 
• You can also open documents using the key combination 

[CTRL][O].  This will invoke the File Open dialog – follow the 
steps outlined above to select and open the file that you want. 
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Section 3 

Navigation 

Objectives: 
By the end of this section you will be able to: 

 Use the Mouse to navigate  

 Use the Keyboard to navigate 

 Use Go To dialog box 
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Navigation 

When working with documents that are several pages long, you need some quick methods 
for moving the cursor to specific locations.  

The Mouse  
When the mouse pointer is positioned over text on the screen, it displays as an “I” beam.  
This mouse shape can be used to anchor the cursor at a particular point so that edits can 
be made.  Simply click the “I” beam where you want to put the cursor. 

If you want to view or edit information not currently visible, use the scroll bars to move 
the document display and then click the “I” beam where you wish to start editing. 

The Keyboard  
The table below lists keystrokes that can be used to move in a document: 

 

 [ ] Move the cursor one character to the right 

[ ] Move the cursor one character to the left 

[ ] Move the cursor up one  line

[ ] Move the cursor down one line

[CTRL][ ] Move the cursor right one word at a time 

[CTRL][ ] Move the cursor left one word at a time

[CTRL][ ] Move the cursor up one paragraph at a time 

[CTRL][ ] Move the cursor down one paragraph at a time 

[HOME] Move the cursor to the beginning of the current line 

 [END] Move the cursor to the end of the current line 

[PAGE UP] Move up a screen

[PAGE DOWN] Move down a screen

[CTRL][HOME] Move to the beginning of the document

[CTRL][END] Move to the end of the document
Figure 17 – Movement Keys 
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Goto 
The Go To function within Word can be used to move you to specific items in a 
document, for example a specific page number. 

[F5] is the Microsoft Office Goto key.  Pressing [F5] calls up the Go To dialog box: 

 
 

Figure 18 - Goto dialog 

The default for the Go to what list is page number.   

 

 To move to a page: 
Keyboard 
• Press [F5]. 

Or 
• Press [CTRL][G]. 

• Type the number of the page you want to move to in the text box 
and click OK or press [ENTER] to move there.   

Word gives other alternatives (lines, sections etc.) which are also numbered within the 
document and can therefore be referenced when moving. 
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Section 4 

Selecting Text 

Objectives: 
By the end of this section you will be able to: 

 Select text using the mouse 

 Select text using the keyboard 

 Select non-concurrent text 

 



Word 2002 Essentials 

Selecting Text 

http://www.mousetraining.co.uk Page41 © The Mouse Training Company 
   

Selecting text 

Highlighting text with the mouse or keyboard is essential for most commands that you 
issue in Word as you normally select text and then perform an action on the selected text. 

When using the mouse to select text, the mouse pointer shape being displayed is 
important as you can perform different actions with different mouse pointers. The mouse 
pointer will appear as an “I” beam when your mouse is hovering over text in the 
document. However, when you hover your mouse in the selection bar (the left margin of 
the page), the mouse pointer will display as a right hand facing diagonal arrow. The 
diagram below shows you where to hover your mouse to get the different types of mouse 
pointer. 

 To select text 
Mouse 
• Use one of the actions in the table below to select the required 

amount of text. 

 Pointer Shape Action Result 

Mouse pointer 
hovering over text 

“I” beam Click and drag over some 
text 

Highlights the text the 
mouse passed over 

 “I” beam Double-click on a word Selects the word and 
the trailing space 

 “I” beam Hold down the [CTRL] key 
and click the mouse over a 
sentence 

Selects the sentence 

From the selection 
bar  Click next to a line of text Selects the whole line 

  Click next to a line of text 
and drag down the selection 
bar 

Selects multiple lines 

  Double click next to a 
paragraph 

Selects the whole 
paragraph 

  Triple click in the selection 
bar 

Selects the whole 
document 

Figure 19 - Select text with the mouse 
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Keyboard 
• To select text using the keyboard, hold down the [SHIFT] key and 

follow the instructions in the table below to select the required 
amount of text. 

 

Action Result 

[SHIFT][ ] Select one character to the left 

[SHIFT][ ] Select from the cursor up one line 

[SHIFT][ ] Select from the cursor down one line 

[SHIFT][CTRL][ ] Select right word by word  

[SHIFT][CTRL][ ] Select left word by word 

[SHIFT][CTRL][ ] Select up one paragraph at a time 

[SHIFT][CTRL][ ] Select down one paragraph at a time 

[SHIFT][HOME] Select from the cursor to the beginning of the 
current line 

[SHIFT][END] Select from the cursor to the end of the 
current line 

[SHIFT][CTRL][HOME] Select to the beginning of the document 

[SHIFT][CTRL][END] Select to the end of the document 

[CTRL][A] Select the entire document 

 
Figure 20 - Keyboard shortcuts for text selection 
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Extend Mode 

If you prefer, you can select blocks of text using Extend mode.   

 

 To switch Extend mode on: 
Keyboard 
• Press [F8] (EXT appears on the status bar).   

• Each time you press [F8] again, word increases the amount of text 
in the selection – 1 press selects the current word, a second press, 
the current sentence and so on.   

 To switch Extend mode off: 
Keyboard 
• When the required amount of text has been selected, press [ESC] 

to turn off Extend mode. 

 

Selecting non-concurrent text 

New in Word 2003 is the ability to select areas of non-concurrent text. For example, you 
can select a paragraph at the top of a page and a sentence towards the bottom of the page. 
This then gives you the ability to perform an action (e.g. deletion, formatting) on the non-
concurrent areas of text you have selected. 

 

 To select items that are not next to each other: 
Mouse and Keyboard 
• Select the first item you want, such as a table cell or paragraph. 

• Hold down CTRL.  

• Click and drag with your mouse to elect any additional items you 
want.  
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Section 5 

Editing Tools 

Objectives: 
By the end of this session you will be able to: 

 Move and Copy text 

 Move and Copy text between documents 

 Use the clipboard task pane 

 Insert a file 
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Move & Copy  

Having entered text or pictures in a document, you may decide that you need to reposition 
them or, you may want to use a paragraph in another document that you have created.  
The good thing about Word is that once you have entered something once, you can move 
or copy it anywhere – to other Word documents and even to files that belong to other 
applications. 

All Microsoft products use the same terminology when describing moving and copying 
items – cut, copy and paste.  These terms stem from the times when typesetters would lay 
out templates by physically cutting an item from its current location, and glueing or 
pasting it in to the new location. 

Moving items 

 To move items: 
Mouse 
• Select the item that you want to move.  

• Click the Cut button on the Standard toolbar.  The selected item 
will disappear from the document (Word holds it in a temporary 
storage area called the Clipboard). 

• Position the cursor where you want to place the item you cut. 

• Click the  button from the Standard toolbar.  The text or picture 
will reappear. 

Or 
Keyboard 
• Select the item you want to move. 

• Press [CTRL][X] to cut the item out – it will disappear from its 
current location. 

• Position the cursor where you want the item to reappear. 

• Press [CTRL][V] to paste the item back into the document. 
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Copying items 

 To copy items: 
Mouse 
• Select the item that you want to copy. 

• Click the  button from the Standard toolbar.  Word will place a 
duplicate of the selected item on the clipboard. 

• Position the cursor where you want the copy to go. 

• Click the  button from the Standard toolbar.  The copied text or 
picture will appear. 

Or 
Keyboard 
• Select the item you want to copy. 

• Press [CTRL][C] to make a copy of the item that Word will store 
on the clipboard. 

• Position the cursor where you want the copy to go. 

• Press [CTRL][V] to paste the copy back into the document. 

• When you have copied or moved the text, Word will display the 
Paste Options button at the end of the moved or copied text. 

• Normally, when you copy or move text, the text’s formatting is 
copied or moved along with it. If you want to copy or move the 
text without transferring its formatting, click the Paste Options 
button and choose Keep Text Only from the drop-down menu. 

Paste Options button 
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Drag and Drop 

You can move and copy items by selecting and dragging them with the mouse, a process 
known as drag and drop. 

 

 To Move: 
Mouse 
• Select the item you want to move. 

• Position the mouse over the selected area – the pointer will 
change to a white arrow that points up and to the left.  This is the 
pointer shape that can be used for moving or copying text. 

• Click and hold the left mouse button down as you move the 
mouse down or up through the document until you can see the 
location that you want to move the selected items to.  You will see 
a fuzzy box around the arrow stalk and also a fuzzy cursor that 
will follow your mouse as you move it. 

• Place the fuzzy cursor where you want the selected items to move 
to and release the mouse button – you will see the selection jump 
to its new location. 

 To copy: 
Mouse 
• If you want to copy the selection, repeat steps one and two above 

but before clicking on to it hold down the [CTRL] key on the 
keyboard, then begin clicking and dragging. You will see a plus 
sign appear in the box around the pointer stalk to signal the fact 
that you are copying rather than moving.   

• With the fuzzy cursor positioned where you want the copy, let go 
of the mouse first and then release the [CTRL] key. 

 Turn on or off drag-and-drop editing 
Menu 
• On the Tools menu, click Options, and then click the Edit tab.  

• Select or clear the Drag-and-drop text editing check box.  

 

 

 
+
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Moving and Copying between documents 

You can use any of the methods described above (even drag and drop) to move and copy 
items from one document to another.  When doing this, it is useful to be able to arrange 
the screen so that you can see the source document (the document containing the items 
that you want to move or copy) and the destination document (the document where you 
want to put them) at the same time. 

 

 To view open documents: 
Mouse 
• Open both documents using the techniques described in the File 

Operations section. 

• Click on the title of the file on the windows task bar at the bottom 
of the screen, or Click Window, from the menu bar (you will see 
that the bottom section of this menu lists the files that are 
currently open) and choose the name of the file you wish to switch 
to 

• To view the documents at the same time, click Window, from the 
menu bar  and choose Arrange All.  The two documents will be 
tiled on screen one above the other, each in its own window. 

Use your preferred technique (as described above) to move or copy items from one 
document to the other.  
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Clipboard Task Pane 

The Microsoft Office Clipboard allows you to collect text and graphic items from any 
number of Office documents or other programs and then paste them into any Office 
document. For example, you can copy some text from a Microsoft Word document, some 
data from Microsoft Excel, a bulleted list from Microsoft PowerPoint, some text from 
Microsoft FrontPage or Microsoft Internet Explorer and a datasheet from Microsoft 
Access, then switch back to Word and arrange any or all of the collected items in your 
Word document.  

Office Clipboard works with the standard Copy and Paste commands. Just copy an item 
to the Office Clipboard to add it to your collection, then paste it from the Office 
Clipboard into any Office document at any time. The collected items stay on the Office 
Clipboard until you exit Office.  

To copy items to the Office Clipboard, they must be displayed in the task pane of an 
Office program or the Collect Without Showing Office Clipboard option must be turned 
on.  

You can open the Office Clipboard in the task pane by clicking Office Clipboard on the 
Edit menu or the Office Clipboard is automatically opened when you do one of the 
following, provided the Show Office Clipboard Automatically option is selected:  

 Copy or cut two different items consecutively in the same program.  

 Copy one item, paste the item, and then copy another item in the same program.  

 Copy one item twice in succession.  

 

To turn the Show Office Clipboard Automatically option or another Clipboard option on 
and off, click the Options button near the bottom of the Cliupboard task pane. 

 

Note: If you choose the Collect Without showing Office Clipboard option, 
the Office Clipboard is always active, even when the Clipboard task pane 
is not displayed. 

 

If you open the Office Clipboard in the task pane of one Office program, the Office 
Clipboard does not automatically appear when you switch to another Office program. 

The Clipboard 
Task Pane 
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Figure 21 - The Clipboard Task Pane 

However, while the Office Clipboard is active, each block of text or graphics that you 
copy or cut to the Clipboard is stored, up to a maximum of 24 blocks. A message is 
displayed above the status area to indicate an item has been added to the Office Clipboard 
and the total number of items in the clipboard.  

 

As items are added to the Office Clipboard, an entry is displayed in the Office Clipboard 
gallery. The newest entry is always added to the top of the gallery. If you copy a 25th 
item, the Office Clipboard discards the first one. 

Each entry includes an icon representing the source Office program and a portion of 
copied text or a thumbnail of a copied graphic. 
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 To paste using the Office Clipboard: 
Mouse 
• Select the item you want to copy or cut and use one of the copy or 

cut techniques described earlier. 

• Continue copying items from documents in any Office program 
until you have collected all of the items you want (up to 24). 

• If you want to display the Office Clipboard in the active program, 
click Office Clipboard on the Edit menu. 

Note:  If the Office Clipboard is not available, you are in a program or 
view that doesn't support showing or pasting multiple items from the 
Office Clipboard.  

• Click where you want the items to be 
pasted and simply click the description of 
the item in the list.  

 

Note: In some cases such as text, the image displayed in the gallery will 
look slightly altered. This is because text is always displayed in the gallery 
using the Tahoma font. However, the correct formatting and font 
information is restored when the item is pasted from the gallery.  

• You can also paste or delete an item from the 
clipboard by clicking the down arrow that 
appears to the right of the description when 
you move the pointer over it and choosing a 
command from the drop-down menu. 

 

 

• To paste all items stored in the clipboard, click the Paste All 
button at the top of the Clipboard task pane. The items will be 
inserted into the document in the order in which they were copied 
to the Clipboard, i.e. the bottom item will be pasted first and the 
top item last. To remove all items from the Clipboard, click the 
Clear All button. 
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Insert a file 

If you need to copy the entire contents of one file into another, you can use a command 
on the Insert menu. 

 To insert a file: 
Menu 
• Position the cursor at the point where you want to insert the file. 

• Choose Insert from the menu bar and then File.  The following 
dialog box will appear: - 

Figure 25 - Insert File dialog 

 

• Select the folder containing the file you want to insert and then 
click the file name to highlight it. 

• Click the Insert button to insert the file. 
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.Notes 
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Section 6 

Formatting 

Objectives: 
By the end of this section you will be able to: 

 Change the font style and size of 
characters 

 Apply formatting effects to characters 
such as Bold, Italic and underline 

 Change the alignment of paragraphs 

 Indent paragraphs 

 Use advanced font and paragraph formats 

 Apply borders 

 Apply bullets and numbering 
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Formatting 

Word divides formatting into two types – Character formats and paragraph formats.  
Character formats can be applied to individual characters within a document.  They 
include bold, italic and different font styles and sizes.  Paragraph 
formats affect whole paragraphs and control the layout of text on a page such as 
alignment, indents and so on. 

Character formats 

Word is best suited to applying formats to text that has already been typed.  It is often 
better to get the raw information in the document without worrying about how it looks 
and then going back afterwards and applying the formats. 

Formatting toolbar 
The formatting toolbar contains buttons for applying some of the most commonly used 
formats. 

 

 
Font Style 
The font style controls what individual characters look like.  True Type fonts will always 
look the same on screen as in a printed copy.  Some fonts are serifed (the characters have 
“curly” edges, whilst others are plain (sans serif). 

 To change the font:  
Mouse 
• Select the text to change. 

• Click on the drop-down list arrow to the 
right of the currently displayed font name.   

• Select the font to use – the selected text will 
alter accordingly 

Or 
Keyboard 
• Select the text to change. 

• Press [CTRL][SHIFT][F] to highlight the current font on the 
formatting toolbar. 

Figure 26 - Formatting 
Toolbar 
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• Use [ALT] [↓] to drop down the list of available fonts, use the up 
and down arrows to move the highlight bar up and down the list 
and [ENTER] to apply the chosen font to the selected text. 

Point Size 
This controls the size of the printed characters. 

 To change the point size : 
Mouse 
• Select the text to change. 

• Click on the drop-down list arrow to the right of the currently 
displayed point size.   

• Pick a new number from the list – the selected text will change 
size accordingly. 

Or 
Keyboard 
• Select the text to change.   

• Press [CTRL][SHIFT][P] to highlight the current point size on the 
formatting toolbar.   

• Either type the point size that you want to use (your typing will 
replace the currently selected number) or use [ALT][↓] to display 
the list of point sizes and move the highlight bar to the selected 
size using the up and down arrow keys.   

• Press [ENTER] to apply the currently highlighted size to the 
selected text. 

Note: Although Word displays from 8 to 72 points in the list, you can type 
your own numbers in and press [ENTER] to apply the format. 
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Bold, Italic and Underline 
Bold, italic and underline can be applied to the selection using buttons on the formatting 
toolbar or keyboard shortcuts. 

  Apply bold, italic or underline:  
Mouse 

• Select the text to change.  

• Click on either the B, I  or U buttons on the toolbar.  The button 
will “switch on” and the selected text will display the applied 
format. 

Or 
Keyboard 
• Select the text to change.   

• Press [CTRL][B] to apply bold formatting, [CTRL][I] to apply 
italic formatting or [CTRL][U] to apply single underline 
formatting to the selected text. 

 Remove Bold, Italic and Underline: 
Mouse 
• Select the text with the format. 

• Click the Bold, Italic or underline button to turn the format off. 

Or 
Keyboard 
• Select the text with the format. 

• Press [CTRL][B], [CTRL][I] or [CTRL][U] to switch the format 
off. 
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Text highlights 
Just as you can use a fluorescent marker to highlight the salient points on a printed page, 
Word allows you to highlight text on screen. Highlights will show in the printed 
document in colour if you have a colour printer, or in grey tones if you have a black and 
white printer. 

 

 To highlight text:  
Mouse 

• Click the button to switch the highlight tool on.  

• Drag your mouse over the text to highlight. 

• When you have finished, click the highlight button once more to 
switch the tool off.  

 To remove highlighting: 
Mouse 
• Select the text that has the highlighting.  

• Click the drop down list arrow on the right of the Highlight 
button. 

• Choose None to remove highlighting from the selected text. 

Note: If you would like to highlight using a different colour, click the 
drop-down list arrow to the right of the highlight button and choose the 
desired colour from the options that appear, then drag across the text to 
highlight.   

Font Colour 
This will change the colour of on-screen text.  It will also print the text in the chosen 
colour if you are connected to a colour printer. 

 To change font colour:  
Mouse 
• Select the text you want to change.  

• Click the drop-down list arrow displayed 
on the right-hand side of the button and 
choose the desired colour. 
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 To reset font colour: 
Mouse 
• Select the text you want to reset to the default colour. 

• Click the drop-down list arrow displayed on the right-hand side of 
the Font colour button. 

• The Automatic option will reset text back to the default colour 
(normally black). 

Other Font formats 
The Formatting toolbar contains the most commonly applied formats, however there are 
more options available in the Format Font dialog box. 

 

 To access the Font dialog box: 
Mouse 
• Select the text to format. 

• Click on the Format option on the Menu Bar and choose Font.  
The following dialog box will appear: 

 Figure 26 - Format 
Font dialog 
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The dialog box contains three tabs – Font, Character Spacing and Text Effects 
which are discussed below. 

Font Tab 
Many of the options on the Font tab are the same as those on the formatting toolbar, 
however, the Underline options include some extra underline styles.  The dialog box 
also has more effects than can be achieved using the formatting 
toolbar. 

 To apply underline styles:  
Mouse 
• Select the text to format. 

• Access the Font dialog and click the Font 
tab. 

• Click the drop-down arrow to the right of the Underline box – a 
list of different underline options will appear.   

• Choose your preferred option by clicking on it.  The Preview 
window at the bottom of the dialog box displays a preview of how 
your text will look if you choose to keep the applied formats. 

• Click the OK button to keep the format.  Clicking Cancel will 
abandon any choices you have made and close the dialog box. 

Effects 

Most of the effects change the appearance of the characters. Superscript and 
Subscript allow you to raise and lower characters (e.g. 10m2 or H2O).   

Some effects have more useful functions – for example Hidden renders text on-screen 
and in the printed document invisible, particularly useful if you want to hide references to 
the source of a document or picture so they don’t get printed.  Note however than Hidden 
text will show on-screen if the Show/Hide button is clicked on. 
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 To apply effects:  
Mouse 
• Select the text to format. 

• Access the Font dialog and click the Font tab. 

• Check the boxes by clicking in them with the mouse next to the 
relevant options to switch an effect on.  The Preview window will 
show you what each one looks like.   

• Uncheck the boxes to switch an effect off. 

Note: Some effects can be switched on in combination, others are 
mutually exclusive (for example you cannot have both Small Caps and 
All Caps applied as switching one on will automatically disable the 
other. 

Character Spacing Tab 
This tab contains options that allow you to increase or decrease the amount of space 
between individual characters in a word, or raise or lower those characters in relation to 
the other characters positioned on the same line.  The Preview window at the bottom of 
the dialog will display what the selected text will look like as you change the settings. 

Figure 27 - Character Spacing tab 
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Scale 
Changes the size and space between the individual characters in the selection.  

 To alter the scale: 
Mouse 
• Select the text to format. 

• Access the Font dialog and click the Character Spacing tab. 

• Click the drop down list next to the default Scale setting to list 
other percentage scales, some bigger and some smaller than the 
current figure.  

• Choose a larger number to increase the space between the 
characters in the selected text and make the characters 
proportionally larger as well.  Choose a smaller figure to squash 
characters together and also decrease their size in proportion to 
the scale percentage chosen. 

Spacing 
Changes the space only between the individual characters without altering their size. 

 To change spacing:  
Mouse 
• Select the text to format. 

• Access the Font dialog and click the Font tab. 

• Click the drop down arrow to the right of the Spacing option. 

• Choose “Expanded” (more space between the individual  
characters) or “Condensed” (less space between the individual 
characters).   

• Use the By box which has up and down arrows that can be 
clicked to increase or decrease by how many points (or tenths of 
points) the characters are expanded or condensed.  

Position 
“Normal” position places the characters on the same level as the other characters on that 
line.   You can choose to have text raised or lowered instead. 

 To change character position: 
Mouse 
• Select the text to format. 
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• Access the Font dialog and click the Font tab. 

• Display the list by clicking the arrow to the right of the Position 
box. 

• Choose “Raised” or “Lowered” – the By box then 
allows you to increase or decrease (again in tenths 
of points) by how much your characters should 
deviate from the base line position. 

 

Note: The By boxes described above will allow you to type the number of 
points by which you want to change a setting rather than using the arrow 
keys to reach the desired figure.  Simply click inside the box to get a 
cursor, delete the number already there and type the new number. 

Kerning 
You need this option because some fonts are proportional and others are not.   

A proportional font will adjust the amount of space between one character and the next 
depending on what that character is; for example the letter “l” is a thin character and does 
not need as much space as an “e”.   

Non-proportional fonts allocate the same amount of space for each character regardless of 
its width.  The Points and above box allows you to set a size above which Word will 
kern the fonts – if you are using a proportional font and you have used the Spacing 
option, you may need to switch the Kerning on to prevent the same amount of spacing 
being allocated to each character. 

 To activate kerning: 
Mouse 
• Select the text to format. 

• Access the Font dialog and click the Font tab. 

• Click in this check box to switch kerning on. 

• Use the Points and above box to set the size at which Word 
will begin to kern fonts. 

• When you have set all the options you require on this tab, click 
OK to apply them.  Cancel will abandon any changes you may 
have made. 
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Text Effects Tab 
The Text Effects tab contains a list of animation effects that can be attached to text in a 
document.  These effects will show up on-screen but do not appear in print outs (the text 
still prints but the effects do not). 

 
Figure 28 – Text Effects Tab 

 

 To apply text effects effects:  
Mouse 
• Select the text to format. 

• Access the Font dialog and click the text effects tab. 

• Choose the effect you want to apply to the selected text, the 
Preview window will show you what the effect looks like should 
you choose to apply it.  Only one effect at a time can be chosen. 

• Click the OK button to keep the change or the Cancel button to 
abandon it. 
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Keyboard shortcuts for character 
formatting 

It is sometimes quicker to use key combinations to apply formatting to text within a 
document and the table below lists the shortcut keys that you can use to do this: 

Increase the font size [CTRL][SHIFT][>] 

Decrease the font size [CTRL][SHIFT][<] 

Increase the font size by 1 point [CTRL] ] 

Decrease the font size by 1 point [CTRL] [ 

Display the Format, Font dialog [CTRL][D] 

Change the case of letters [SHIFT][F3] 

Format letters as all capitals  [CTRL][SHIFT][A] 

Apply bold formatting [CTRL][B] 

Apply an underline  [CTRL][U] 

Underline words but not spaces [CTRL][SHIFT][W] 

Double-underline text [CTRL][SHIFT][D] 

Apply hidden text formatting [CTRL][SHIFT][H] 

Apply italic formatting [CTRL][I] 

Format letters as small capitals  [CTRL][SHIFT][K] 

Apply subscript formatting (automatic 
spacing) 

[CTRL][=] 

Apply superscript formatting (automatic 
spacing) 

[CTRL][SHIFT][+] 

Remove manual character formatting [CTRL][SPACEBAR] 

Figure 29 - Keyboard shorcuts for character formatting 
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Paragraph Formats 

When you need to control how a paragraph lines up on a page, you apply paragraph 
formats.  As with character formatting, some of the most commonly used options appear 
as buttons on the Formatting toolbar whilst others can only be accessed via the Paragraph 
dialog box. 

Alignment 

You can select from four different alignment options in Word by clicking the relevant 
button (described below) : 

 To change alignment: 
Mouse 
• Position the cursor in the paragraph whose alignment you want to 

change, or if you are aligning several paragraphs, highlight them. 

• Click on the button for the alignment you require (see below). 

 Click this button to left-align paragraphs.  Left alignment 
ensures that the left edge of each line in the paragraph 
begins at the same place.  Because of the word-wrapping, 
the right-hand edge of the paragraph won’t line up exactly, 
this is sometimes called a “ragged” edge.  Left alignment 
is the default alignment for new Word documents. 

 Click this button to centre paragraphs.  This will make 
each line of the paragraph position its centre point in the 
middle of the page.  Both the left and right edges of the 

paragraph will be ragged. 

 

 Click this button to right-align paragraphs.  Right 
alignment ensures that the right edge of each line in the 

paragraph begins at the same place – the left edge will be 
ragged. 

 

 Click this button to justify paragraphs.  This ensures that 
both the left-hand and right-hand edges of the lines in the 
paragraph begin and end at the same position, eliminating 
any ragged edges. 
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Or 
Keyboard 
• Click the cursor inside the paragraph whose alignment you want 

to change or, if you are aligning several paragraphs, highlight 
them. 

• Press [CTRL] [L] to left align, press [CTRL] [R] to right align, 
press [CTRL] [E] to centre or [CTRL] [J] to justify. 

Indents 

Indents allow you to control the white space at the left and right hand side of a paragraph. 
There are a variety of different methods for setting indents which are described below. 

 To indent from the left: 
Mouse 
• Click the cursor inside the paragraph whose alignment you want 

to change or, if you are aligning several paragraphs, highlight 
them. 

• Click the increase indent button to indent the selected paragraphs 
by ½ an inch from the left. You can click this button again to 
increase by a further ½ inch and so on. 

• If you need to decrease the indent by ½ inch, click the decrease 
indent button to do this. 

Or 
Keyboard 
• Click the cursor inside the paragraph whose alignment you want 

to change or, if you are aligning several paragraphs, highlight 
them. 

• Press [CTRL][M] to increase the indent of the selection ½ inch 
from the left. 

• Press [CTRL][SHIFT][M] to decrease the indent by ½ inch. 
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Use the ruler to set indents 
The buttons on the toolbar allow you to indent a set amount from the left only.  If you 
need to indent a paragraph from the right, or you want the indent to be a very specific 
amount, it is easier to use the ruler. 

The markers displayed above sit on the ruler.  The first line indent marker controls the 
first line position of the paragraph and the hanging indent marker the position of all lines 
following the first line. The left indent rectangle that sits under them maintains any gap 
between the first line marker and the hanging indent marker so the two can be moved 
together. The right indent marker controls where the paragraph ends. 

 

 To create a left indent using the ruler: 
Mouse 
• Position the cursor in the paragraph to indent or select the text if it 

includes more than one paragraph. 

• Click on the rectangle (left indent) that sits on the ruler and drag 
this along the ruler – you will see a vertical guideline that draws 
itself down into your document to help you decide where the 
paragraph indent should be.   

• Release the mouse to set the indent. 

 To create a right indent: 
Mouse 
• Position the cursor in the paragraph to indent or select the text if it 

includes more than one paragraph. 

• Click on the upward triangle that sits on the right-hand side of the 
ruler (right indent marker) and drag this along the ruler – you will 
see a guideline that draws itself down into your document to help 
you decide where the paragraph indent should be.   

• Release the mouse to set the indent. 

Right-indent 
 marker 

First line  
indent 
marker 

Hanging 
Indent Marker 

Left Indent 
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First line indent 
A first line indent is used where the first line of a paragraph needs to start further in than 
the other lines as in the example below: 

“It is company policy to ensure that 
all staff are fully trained in the use of the 
computer systems employed by the firm so 
that they may carry out their daily duties in 
the most efficient way.” 

 To create a first line indent: 
Mouse 
• Position the cursor in the paragraph to indent or select the text if it 

includes more than one paragraph. 

• Click on the downward triangle marker (first line marker) that sits 
on the left-hand side of the ruler and drag this along the ruler – a 
guideline appears that the first line will jump to when you release 
the mouse. 

 To remove the first line indent: 
Mouse 
• Position the cursor in the paragraph to change or select the text if 

it includes more than one paragraph. 

• Drag the first line marker back so that it lines up with the other 
markers. 

Note: Having created a first line indent, if you then want to indent the 
whole paragraph, use the rectangular marker (under the upward triangle).  
Dragging this marker moves both the triangles but will keep any gap 
between them constant. 

Hanging Indent 
A hanging indent is used where the first line of a paragraph needs to start further back 
than the other lines as in the example below: 

“It is company policy to ensure that all staff are 
fully trained in the use of the computer 
systems employed by the firm so that they 
may carry out their daily duties in the most 
efficient way.” 
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 To create a hanging indent: 
Mouse 
• Position the cursor in the paragraph to indent or select the text if it 

includes more than one paragraph. 

• Use the left indent marker to indent the whole paragraph from the 
left the desired amount 

• Drag the upward triangle (hanging indent marker) back along the 
ruler – a guideline will appear to show you where all lines (except 
the first line) in your paragraph will jump to when you release the 
mouse. 

Or 
Keyboard 
• Position the cursor in the paragraph to indent or select the text if it 

includes more than one paragraph. 

• Press [CTRL][T] 

 To remove a hanging indent: 
Mouse 
• Position the cursor in the paragraph to format or select the text if 

it includes more than one paragraph. 

• Drag the hanging indent marker back so that it lines up with the 
other markers. 

Or 
Keyboard 
• Position the cursor in the paragraph to format or select the text if 

it includes more than one paragraph. 

• Press [CTRL][SHIFT][T] 

Note: Having created a hanging indent, if you then want to indent the 
whole paragraph, use the rectangular marker (left indent, under the 
upward triangle).  Dragging this marker moves both the triangles but will 
keep any gap between them constant. 
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Other Paragraph Formats 

The most commonly applied paragraph formats can be set using the buttons on the 
formatting toolbar as described in the previous section, however there are further formats 
that can be accessed using the Paragraph dialog box. 

 

 To access the paragraph dialog: 
Menu 
• Position the cursor in the paragraph to format or select the text if 

several paragraphs are involved.. 

• Click on the Format option on the Menu Bar and choose 
Paragraph.  The following dialog box will appear: 

 

Figure 30 - Paragraph Dialog 

 

This dialog box has two tabs, Indents and Spacing, Line and Page Breaks that are 
discussed below. 
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Indents and Spacing Tab 
Most of the options on this tab are for formats that can be accessed through other means.  
The Alignment drop-down list allows you to pick one of the four alignment options that 
can also be applied using the formatting toolbar.  The Indentation options relate to the 
amount of left or right indent to be applied, and the Special and By settings allow you to 
set up first line and hanging indents using the By box to control the amount of each.  The 
options outlined below can only be applied through the dialog or via keyboard shortcuts. 

Spacing 
Use these settings to control how much white space appears before and after the selected 
paragraph or paragraphs.  You can increase white space by inserting blank lines (i.e. 
pressing the [ENTER] key) but this can be time consuming and sometimes inconsistent.   

The Line Spacing list allows you to increase the space Word allocates between each 
individual line in a paragraph.  There are several settings which are described below: 

Multiple 
Choose this option and then use the At box to give the number of lines by which you 
would like to space your paragraphs.   

The default is 3, but you can change the numbers either by using the arrows to increase 
and decrease, or by selecting the number and typing a new one over it. 

At Least 
With the At Least setting, if any of the characters within the selected paragraph are set to 
more than 18 pts size, the line spacing will adjust to accommodate it.   

Choose this option and then use the At box to give a minimum number of points by 
which your lines should be spaced out (e.g. 18 pts).   

Exactly 
With the Exactly setting, characters within the selected paragraph that are larger than the 
line space amount will be cut off.   

Choose this option and then use the At box to give an exact number of points by which 
your lines should be spaced out (e.g. 18 pts).   

 To change paragraph spacing:  
Mouse 
• Select the paragraphs to change. 

• Access the Paragraph dialog and click the Indents and 
Spacing tab. 

• Click the up or down arrows on the right of the Before and After 
boxes to increase or decrease the number of points of space before 
and after – the numbers jump in increments of 6pts but you can 
select the number already there and type in any number of points 
as appropriate.   
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• The Preview pane towards the bottom of the dialog shows what 
your paragraph(s) will look like.   

• Click the OK button to confirm the format change and close the 
dialog, or click Cancel to close the dialog, abandoning any 
changes you have made to the settings within. 

 To change line spacing:  
Mouse 
• Select the paragraphs to change. 

• Access the Paragraph dialog and click the Indents and 
Spacing tab. 

• To space out the individual lines within a paragraph, first choose 
the amount of space you require by clicking on the drop-down list 

to the right of the Line Spacing box.   

• Select the required option detailing the amount of spacing to be 
applied, (Single, Double, 1.5).   

• The Preview pane towards the bottom of the dialog shows what 
your paragraph(s) will look like.   

• Click the OK button to confirm the format change and close the 
dialog.  Cancel closes the dialog, abandoning any changes you 
have made to the settings within. 
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Line and Page breaks Tab 
Settings on this tab primarily control how Word will insert automatic page breaks. 

 
Figure 31 - Line and page breaks tab 

Pagination 

Widow/Orphan control 

As this is a very useful option, most installations of Word will switch it on for all 
paragraphs by default.  It prevents page breaks falling right after the first line of a 
paragraph leaving the first line stranded at the bottom of a page (i.e. a “widow”).  The 
“orphan” is where a page break falls just before the last line of a paragraph, leaving the 
final line stranded at the top of a page.  

Keep lines together 

This option prevents Word from putting a page break through a paragraph.   

Keep with next 

This ensures that the selected paragraph(s) will never be split by page breaks. 

Page break before 

This option would cause the selected paragraph(s) to always appear at the top of a new 
page. 
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 To set Widow/Orphan control: 
Mouse 
• Click the check box to switch Widow/Orphan control on or 

off. 

 To keep lines together: 
Mouse 
• Check this box to prevent an automatic page break falling within 

the selected paragraph(s).   

 To keep with next: 
Mouse 
• Check this box to prevent the selected paragraph(s) from being 

separated from the next paragraph by an automatic page break. 

 To set page break before: 
Mouse 
• Check this box to ensure that the selected paragraph(s) always 

begins on a new page. 

Keyboard shortcuts for paragraph formatting 
It is possible to access all paragraph formats through the Format, Paragraph dialog box. 
However, it can be quicker to apply paragraph formats using keyboard shortcuts. Some 
useful shortcuts are listed in the table below.  

 

Single-space lines [CTRL][1] 

Double-space lines [CTRL][2] 

Set 1.5-line spacing [CTRL][5] 

Add or remove one line space preceding a paragraph [CTRL][0] 

Centre a paragraph [CTRL][E] 

Justify a paragraph [CTRL][J] 

Left align a paragraph [CTRL][L] 

Right align a paragraph [CTRL][R] 

Indent a paragraph from the left [CTRL][M] 

Remove a paragraph indent from the left [CTRL][SHIFT][M] 

Create a hanging indent [CTRL][T] 
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Reduce a hanging indent [CTRL][SHIFT][T] 

Remove paragraph formatting [CTRL][Q] 

Figure 32 - keyboard shortcuts for paragraph formatting 
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Format Painter 

When you have applied formats to a block of text, there may be other sections within 
your document that need to have the same combinations of formats applied.  To save you 
having to repeat the process of applying the same formats all over again, you can use the 
format painter to pick up the formats from the text that has them and paint them on to the 
text you want to change. 

 

 To use the format painter:  
Mouse 
• Select the text that has the formatting you need. 

 

• Click the Format painter button from the standard toolbar. 

• Drag across the items you want to format.  When you release the 
mouse, the formats will appear on the selected text. 

Note: The Format Painter switches itself off automatically as soon as you 
release the mouse after selecting the text you want to format.  If you have 
more than one item to format, you can make the format painter stay 
“switched on” until you have completed painting the formats onto all the 
items.  Do this by double-clicking the Format Painter button.  When you 
no longer need the Format Painter, click the button once more to switch it 
off or press [ESC] on the keyboard. 

 

If you want to paint paragraph formats onto text, make sure you select the 
paragraph mark at the end of the text that has the paragraph formats 
before you click the Format Painter button. 
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Reveal and Clear Formatting 

The reveal Formatting task pane allows you to view a detailed description of the 
formatting of any text in your document. It describes directly applied character and 
paragraph formatting features, as well as formatting features derived from the paragraph 
style or any character style assigned to the text. You can also use this task pane to modify 
or clear formatting, to compare the formatting of different selections, or to find blocks of 
text of similar formatting. 

 To use the Reveal Formatting task pane:  
Mouse 

• Select the text whose formatting you want to 
review. 

• On the Format menu, click Reveal Formatting. 
The formatting information will appear in the 
Reveal Formatting task pane.  

• To change any formatting properties, click the 
text with a wavy blue underline, and then 
change any options you want in the dialog box 
that appears.  

• To view a feature by feature comparison of the 
selection’s formatting with the formatting of 
another block of text, check the Compare to 
another selection option and select the other 
block of text. 

• To determine the formatting source, such as 
whether the formatting comes from a style, 
select the Distinguish style source check box.  

• To show formatting marks, such as paragraph marks and tabs, 
select the Show all formatting marks check box.  

• To format a text selection like the text that surrounds it, select the 
text. In the Selected text box, click the arrow, and then click 
Apply Formatting of Surrounding Text. 
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• To remove all the formatting from the selected text resetting it 
back to default style, click  the down arrow in the Selected Text 
box and chose Clear Formatting. 

• If you  would like to select all text with simlar formatting, click in 
a word that's formatted like the text you want to select, click  the 
down arrow in the Selected Text box and chose Select all text 
with similar formatting. 

• If you would like to format the selected text based on the 
formatting of the text around it, click Apply formatting of 
surrounding text. 

Remove formatting with the keyboard 

You can remove all the formatting that has been applied and reset the selected text back 
to the document defaults by using the keyboard. 

 

 To remove all character formats: 
Keyboard 
• Select the text to remove the formats from. 

• Press [CTRL][SPACEBAR]. 

 To remove all paragraph formats: 
Keyboard 
• Select the text to remove the formats from. 

• Press [CTRL][Q]. 
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Borders 

Borders can be applied to many different objects in Word; for example, you can add 
borders to tables, paragraph edges or even whole pages in a document.  There are also 
some automatic formatting keystrokes that will add borders to the cursor position in your 
document (See the section on AutoFormatting for more information). 

Clicking on the Borders button on the Standard toolbar displays the Borders drop down 
palette. 

 

 

The buttons on the palette perform the following functions: 

 Applies or removes outside border 

 Applies or removes borders both inside and outside 

 Applies or removes top border 

 Applies or removes left border 

 Applies or removes a border horizontally inside a selection 

 Applies or removes descending diagonal  

 Applies horizontal line 

 Applies or removes inside border 

 Removes all borders 

 
Applies or removes bottom border 

 Applies or removes right border 

 Applies or removes a border vertically inside a selection 

 Applies or removes ascending diagonal 

Figure 33- Border Icons 
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 To add a border to a paragraph: 
Mouse 
• Select the paragraph. 

• Click on any combination of the border tools to determine which 
edges of the paragraph are bordered. 

Changing the paragraph border width 

The width of the border is controlled by the right indent measurement belonging to the 
paragraph.  

 To reduce the width of the border: 
Mouse 
• Click in the paragraph with the border or select the paragraphs if 

more than one paragraph's borders need changing. 

• Drag the indent markers on the ruler to correspond with the new 
border width. 

Borders via the menu 
Borders can be added using the borders dialog available on the Format menu.  Applying 
borders in this way gives you more options as to line style, shading and so on. 

 

 To apply borders using the Borders and Shading 
dialog: 

Mouse  
• Select the 

paragraph(s). 

• Choose Borders 
and Shading from 
the Format menu. 

• Click on the 
Borders tab. 

• Choose the 
required border. 

• Click OK. 

Figure 34 - Borders and Shading Dialog 
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Page Borders 

You are able to apply a border around an entire page. It is generally used in the same way 
as paragraph borders except you have an interesting addition, Art, where you have the 
opportunity to select an artistic page border. You may have to alter the border width so 
that it is not too big. 

 

 To apply a page border: 
Mouse 
• Choose Format, Borders and Shading. 

• Click the Page Border Tab. 

 
• Select the appropriate border from the Setting palette by clicking 

on the picture that you want. 

Or 
• Click the Art drop-down list to select from a range of graphics to 

use as a page border 

• Click OK. 
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Shading 

The third tab within the Borders and Shading dialog allows you to apply shading to a 
paragraph or a piece of text. 

 To add shading: 
Mouse 
• Select what you want to shade (i.e. a word or phrase, or a whole 

paragraph). 

• Choose Format, Borders and Shading and click the Shading tab 
from within the dialog. 

 
• Choose a colour from the colour palette by clicking it. 

• If appropriate, choose a pattern from the Style drop-down list and 
assign a colour to the pattern with the Colour drop-down list. 

• Click OK. 

Do not apply patterns over text as you will not be able to read the text. 

Shortcut Menus 
You can apply both character and paragraph formats using Word’s shortcut menus. 
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 To apply formats using shortcut menu: 
Mouse 
• Select the items to format. 

• With the mouse positioned anywhere 
within the highlighted area, click the right 
mouse button. 

• Select the Font, Paragraph or Indents 
option by clicking on it with the mouse. 
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Bulleted and Numbered lists 

Word has tools for automatically assigning bullets and numbers to lists.  You can choose 
from a variety of different number formats and select which bullet symbols to use.  You 
can also create multi-level lists very easily using this feature. 

With numbered lists, if you move, delete or add items, Word will automatically renumber 
the list so that you always have the correct numeric sequence. 

Bullets 

Bullets are symbols that can be used to denote list items or headings.  They attach 
themselves to paragraphs within a document. 

 To create a bulleted list: 
Mouse 
• Type the list one line under the other. 

• If you want blank lines of space between list items select the lines 
and use the Space after setting in the Paragraph dialog. 

• Click the Bullets button on the formatting toolbar to apply bullet 
symbols to your list (the button will switch on). 

Note: In Word 2003 when you apply bullets, your list is also automatically 
indented from the left margin. If you do not want this indentation you will 
need to remove it. See previous instructions in this section about setting 
and removing paragraph indentations. 

Remove bullets 
When you want to add a paragraph underneath your last list item, you may find that the 
bullets continue.  This is because bullets and numbers are paragraph level formats and 
Word will copy them from one paragraph to the next when you press the [ENTER] key.   

 

 To switch bullets off: 
Mouse 
• Click the cursor on the paragraph where the bullet is, or if the 

bullets are on several paragraphs, select them. 

• Click the Bullets button on the formatting toolbar (the button will 
switch off) 
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Or 
Keyboard 
• Click to position the cursor in front of the bullet to remove. 

• Press [BACKSPACE]. 

Note: If you have switched bullets on and are typing your list, when you 
don’t want the bullets any more, press [ENTER] to begin a new line – the 
bullet will appear but if you press [ENTER] again, Word will assume that 
you have finished your list and remove it accordingly. 

Change bullet style 
When you click the Bullets button, Word applies the bullet symbol that you chose last 
time you used the bullets button.  You may want to use a different symbol. 

 

 To change the bullet symbol: 
Menu  
• Select the bulleted list. 

• From the menu bar choose Format, Bullets and Numbering.  The  

 

• bullets and numbering dialog box will appear. 

• Select the bullet symbols you want to use by clicking on the pane 
within the dialog that matches. 

Figure 35 - Bullets dialog box 
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• Click OK to apply the change and close the dialog. 

Customise a bulleted list 
The bullets and numbering dialog gives you a small selection of pre-picked bullet 
symbols for you to choose from.  If none of those is suitable for your list, you can access 
a palette with a bigger selection of symbols. 

You can also change the indent positions of your list items. 

 

 To customise bullet symbols: 
Menu 
• Select the bulleted list. 

• Choose Format, Bullets and Numbering to access the Bullets and 
Numbering dialog. 

• Click the Customize button.  The following dialog box will 
appear: - 

 

Figure 36 - Customise Bullets dialog 

• Click the Font button to access the Font dialog if you want to 
make changes to bullet size and style. 
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• Click the Character button to select a different symbol.  This calls 
up the symbol palette displayed below: - 

Figure 37 - Symbol palette 

 

• Initially Word displays symbols from the Symbol font.  You can 
choose symbols from a different font by clicking the drop down 
list arrow to the right of the Font box.  

• Note: Wingdings, Webdings and Monotype Sorts have a large 
variety of useful symbols to use for bullet points.  

• Click on a symbol from the palette to select it (clicking also 
magnifies the symbol making it clearer), then click OK to go back 
to the previous dialog.  The selected bullet will be displayed in 
one of the preview panes. 

• Click the Picture button to browse through a gallery of picture 
bullets.  This calls up the symbol palette displayed below: -  
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• Choose a picture from the gallery or click Import to select a 
picture from a different location and click OK 

• Click OK to replace the existing bullets with your custom bullet. 

Note: When you alter the bullet symbol as described above, Word will 
use that symbol for all new lists when the Bullets button is clicked. 

 To change bulleted list indents: 
Menu 
• Select the list. 

• Choose Format, Bullets and Numbering to access the Bullets and 
Numbering dialog.  Click the Customize button. 

• To change the bullet position, set the Bullet position Indent At 
box to the desired measurement by clicking the up and down 
arrows on the right of the box.  The Preview below the dialog 
will display the effects of your changes. 

• To change the tab space, set the Tab space text box to the 
desired measurement by clicking the up and down arrows on the 
right of the box.  The Preview below the dialog will display the 
effects of your changes. 

• To change the distance between the margin and the text, set the 
Text position Indent At text box to the desired measurement 
by clicking the up and down arrows on the right of the box.  The 
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Preview below the dialog will display the effects of your 
changes. 

• Click OK to apply the new indents to the selected items and close 
the dialog. 

Numbers 

You can add numbers to paragraphs in a document.  Word lets you choose between a 
variety of different numbering styles. 

 To create a numbered list: 
Mouse 
• Type the list one line under the other. 

• If you want blank lines of space between list items select the lines 
and use the Space after setting in the Paragraph dialog. 

• Click the numbers button on the formatting toolbar to apply 
numbers to your list (the button will switch on). 

Remove numbers 
When you want to add a paragraph underneath your last list item, you may find that the 
numbers continue.  This is because bullets and numbers are paragraph level formats and 
Word will copy them from one paragraph to the next when you press the [ENTER] key.   

 To switch numbers off: 
Mouse 
• Click the cursor on the paragraph where the number is, or if the 

numbers are on several paragraphs, select them. 

• Click the numbers button on the formatting toolbar (the button 
will switch off). 

Or 
Keyboard 
• Click to position the cursor in front of the number to remove. 

• Press [BACKSPACE]. 

Note: If you have switched numbers on and are typing your list, when you 
don’t want the numbers any more, press [ENTER] to begin a new line – 
the number will appear but if you press [ENTER] again, Word will assume 
that you have finished your list and remove it accordingly. 
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Change numbering style 
Word applies the number style that you chose last time you used the bullets and 
numbering option.  You may want to use a different numbering style. 

 To change the numbering style: 
Menu 
• Select the numbered list. 

• From the menu bar choose Format, Bullets and Numbering. The 
bullets and numbering dialog box will appear.  

 

 

• Select the numbering style you want to use by clicking on the 
pane within the dialog that matches. 

• Click OK to apply the change and close the dialog. 

Customise a numbered list 
You can make some changes to the numbered list styles available within the bullets and 
numbering dialog.  These include changing the separator character, and altering the 
number and text indents. 

 To customise a numbered list: 
Mouse 
• Select the list. 

Figure 39 - Number Dialog box 
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• Choose Format, Bullets and Numbering from the menu bar. 

• From the Bullets and Numbering dialog, click the Customize 
button.  The following dialog box will appear: - 

 
Figure 40 - Customize numbers dialog 

Number Format 
Use this option to add extra digits to numbers (e.g. if you want extra decimal places) or to 
add prefix and suffix characters (e.g. the word “Item”, -dash etc.). 

 To change the number format: 
Mouse 
• Click in the Number format text box. 

• Type in the additional characters or words that you want your 
number format to include. 

• Click OK to return to the Bullets and Numbering dialog.  Click 
OK to close the dialog and apply the changes to the number 
format. 

Number Style 
Word offers a variety of different numbering styles for lists, standard Arabic numbers, 
Roman numerals and so on. 
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 To change the number style: 
Mouse 
• Click the drop-down list arrow to the right of the Number style 

box. 

• Click on the required style from the displayed list. 

• Click OK to return to the Bullets and Numbering dialog.  Click 
OK to close the dialog and apply the changes to the number style. 

 To change the start number: 
Mouse 
• Click on the up and down arrows in the Start At box to increase 

or decrease the start number.  The number style Word offers will 
change according to the number style setting (see above). 

Or 
• Click and drag across the number showing in the Start At box 

and type in the new start number. 

• Click OK to return to the Bullets and Numbering dialog.  Click 
OK to close the dialog and apply the changes to the number style. 

 To change numbered list indents: 
Menu 
• To change the number position, set the Number Position Align 

At text box to the desired measurement by clicking the up and 
down arrows on the right of the box.  The Preview on the right of 
the dialog will display the effects of your changes. 

• To change the text position, set the Text position Indent At 
text box to the desired measurement by clicking the up and down 
arrows on the right of the box.  The Preview on the right of the 
dialog will display the effects of your changes. 

• Click OK to apply the new indents to the selected items and close 
the dialog. 

Continue a List 
Some list points can be several paragraphs long.  When this is the case, you will need to 
switch the numbering off for those paragraphs that “belong” to the previous paragraph’s 
number.  When you are ready to start numbering again, Word will allow you to continue 
using the next number in sequence. 
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 To continue numbering from a previous list: 
Mouse 
• Click in the list item where the numbering should continue, or if 

there are several items to be numbered, select them. 

• Choose Format, Bullets and Numbering to access the Bullets and 
Numbering dialog.  Click the Numbered tab at the top of the 
dialog box. 

• Click the Continue previous list option button towards the 
bottom of the dialog box and choose OK to confirm the change 
and close the dialog box. 

Start a new list 
There may be occasions where you need to end one list and begin a new one straight 
away.  Unless you tell it otherwise, Word will assume that the numbering should follow 
on in sequence from the previous list. 

 

 To restart numbering: 
Menu 
• Click in the list item where the numbering should restart, or if 

there are several items to be numbered, select them. 

• Choose Format, Bullets and Numbering to access the Bullets and 
Numbering dialog.  Click the Numbered tab at the top of the 
dialog box. 

• Click the Restart list option button towards the bottom of the 
dialog box and choose OK to confirm the change and close the 
dialog box. 

Create a multi-level list 
You can create lists using Word’s automatic numbering tools that have many different list 
levels.  This is useful if the list you are creating has subpoints which need to line up 
properly. 

 To create a multi-level list: 
Mouse 
• Type the list one line under the other. 

• If you want blank lines of space between list items select the lines 
and use the Space after setting in the Paragraph dialog. 
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• Choose Format, Bullets and Numbering from the menu bar and 
click the Outline Numbered tab from the Bullets and 
Numbering dialog. 

• Click on the Preview pane that matches the style you want for 
your multi-level list.  Click OK to apply the format to the selected 
list. 

Word will initially use the top level style for all list items.  Use the keyboard to demote 
and promote items to the required levels. 

 

 To demote an item:  
Mouse 
• Position the cursor somewhere in the paragraph, or if you want to 

demote several paragraphs, select them.  Click . 

 To promote an item: 
Mouse 
• Position the cursor somewhere in the paragraph, or if you want to 

demote several paragraphs, select them and Click  . 

Bullets and numbering with the shortcut menu 

You can apply Bullets and Numbering from the shortcut menu that appears when you 
click the right-mouse button over a selection. 

 To use shortcut menu for bullets/numbering 
Mouse 
• Select the items to number or bullet. 

• Position the mouse anywhere over the highlighted area and click 
the right mouse button. 

• From the resulting shortcut menu, choose Bullets and Numbering.  
The Bullets and Numbering dialog will appear. 

• Click the Numbered or Bulleted tab and click on the pane that 
has the style of bullets/numbers you require. 

• Click OK to apply your chosen bullets/numbers. 
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Apply bullets and numbers as you type 
You can tell Word that you are about to type a numbered or bulleted list by starting the 
first list item in a special way.  When you press [ENTER] to start a new line, Word will 
autoformat your current text with standard bullets and numbers. 

 

 To apply bullets as you type: 
Keyboard 
• Start the list by typing an asterisk and then press [TAB].  Type the 

list text immediately after and then press [ENTER].  Word will 
change the asterisk to the standard bullet symbol and start the next 
line with the bullet, ready for you to type the next item. 

 To apply numbers as you type: 
Keyboard 
• Type the first number and press [TAB].  Type the first list item 

immediately after and then press [ENTER].  Word will continue 
the numbering on the new line ready for you to type the next item. 

Space list items 
You can use a soft return to insert blank (un-numbered or un-bulleted) lines between list 
items. This is also sometimes known as a line break rather than a soft return. 

A soft return is entered by pressing [SHIFT][ENTER] on the keyboard. 
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Section 7 

Viewing and Printing 

Objectives: 
By the end of this section you will be able to: 

 Use different views 

 View multiple documents 

 Preview documents 

 Print documents 
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Viewing Your Document 

This section concentrates on the different ways a Word document can be viewed. 

Word provides several different ways a document can be viewed on screen.  The view 
that you choose depends on the type of document that you are creating, and whether 
speedy performance or exact layout is important to you. 

You can switch between different views using the view buttons at the bottom left corner 
of your screen (seen below) or by choosing View from the menu bar and then selecting  

the appropriate view from the list. 

 

 

 

 

 

 
 

Figure 7 - View selector buttons 

 

Normal View 

This view shows the document being viewed or edited as a scrolling list.  Page breaks are 
represented as dotted lines across the screen.  Normal view doesn’t display graphics or 
inserted objects but it is the quickest view for editing and review purposes as it uses less 
memory.  It is therefore a good view to use when working on long documents. 

 To switch to Normal View: 
Mouse 
• Click on the first view selector button (Normal view).  

Or 
Menu 
• Choose View from the menu bar and click the Normal option. 

Print Layout View 

Page Layout View shows the current document exactly as it will be printed out on paper.  
This is very useful for reviewing the layout of a document and checking if the “white 

Normal 

Web Layout 
View

Outline 
View

Reading 
Layout 

Print Layout 
View
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spaces” (i.e. margins, blank lines) look right.  Graphics can be seen in Page Layout view 
so therefore it is a good view to use when inserting pictures and diagrams.  However, 
there is a performance overhead – it uses more memory than Normal view and so with 
large documents, Word may take longer to update changes. 

 

 To switch to Print Layout View: 
Mouse 
• Click the third view selector button (Print Layout). 

Or 
Menu 
• Choose View from the menu bar and click the Page Layout option 

Web Layout View 

Web Layout View shows your document as it would look if you published it to the Web 
or an intranet. In this view, you can see backgrounds, AutoShapes, and other effects that 
are commonly used in Web documents or documents that you view on the screen.  

 To switch to Web layout view: 
Mouse 
• Click on the second view selector button (Web Layout).   

Or 
Menu 
• Choose View from the menu bar and click the Web Layout option 

Outline View 

In Outline View, Microsoft Word simplifies the text formatting to help you focus on the 
structure of your document. Outline view looks very different from other views.  The text 
appears with symbols down the left-hand edge and an extra toolbar is displayed. 

Word indents each heading according to its level. The indentations appear only in outline 
view; Word removes the indentations when you switch to another view. 

When reorganising long documents, outline view gives the user tools for quickly 
repositioning large blocks of text and promoting and demoting heading levels where 
appropriate.  You can also view a document fully expanded, showing headings and their 
detail text, or collapsed (headings only). 

The structure of the document seen in Outline View is controlled by heading styles used 
in the document. The use of heading styles is covered in later Word courses and is 
therefore not dealt with in this manual. 
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 To switch to Outline view: 
Mouse 
• Click the fourth View Selector button.  

Or 
Menu 
• Choose View from the menu bar and choose the Outline option. 

 

 

 

.  

 

Figure 8 - Outline View 
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Document Map 

The Document Map is a separate pane that displays a list of headings in the document. 
Use the Document Map to quickly navigate through the document and keep track of your 
location in it. When you click a heading in the Document Map, Word jumps to the 
corresponding heading in the document, displays it at the top of the window, and 
highlights the heading in the Document Map. You can show or hide the Document Map at 
any time.  

 

 To switch to the Document Map: 
Menu 
• Click Document Map on the View menu. 

Or 
Mouse 

• Click  
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Viewing multiple documents 

In Word, you can view all open documents on the screen at the same time by arranging 
them top to bottom on the screen. 

 

 To view more than one document: 
Menu 
• If the Microsoft Word documents you want to arrange are 

minimized, restore the minimized documents first. 

• On the Window menu, click Arrange All. 

 
Note: To revert back to one document view again on full screen, simply 
maximise one of the windows. 

Figure 9 - Arranged documents 
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Printing 

The open document can be printed in its entirety, or alternatively you can print individual 
pages or ranges of pages. Word gives you the ability to choose which pages you want to 
print, or if you need to be even more specific, you can print only the selected items. 

Before sending any document through to the printer, it is always a good idea to preview 
what the hard copy will look like so that you can rectify any problems before printing it. 

Print Preview 

This is another way that you can view your document.  When you are in print preview, 
Word gives you a special toolbar for changing the number of pages per screen, zooming 
in and out and so on.  If you spot mistakes as you are previewing a document, you can 
even edit in print preview. 

 

 To access print preview:  
Mouse 

• Click the Print Preview  button from the standard toolbar. 

 
Figure 50 - Print preview screen 
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• Click the Next page or Previous page buttons to scroll backwards 
and forwards through your document’s pages. 

Or 
Keyboard 
• Press [PAGE UP] or [PAGE DOWN]. 

The Print preview toolbar 
The print preview toolbar only appears when you are in Print preview.  It gives you useful 
tools for changing such things as magnification and how many pages you can see on one 
screen.  The button functions are described in detail below: 

 

 To close the Print Preview: 
Mouse 
• Click the button marked Close from the Print preview toolbar.  

OR 
Keyboard 
• Press [ESC] on the keyboard. 

Magnification 
When you are in Print preview, Word automatically changes your mouse pointer into a 
magnifying glass that you can use to zoom and out on particular areas of the currently 
displayed page.  

 To change magnification: 
Mouse 
• In the Print preview screen position your mouse over the area that 

you want to zoom in on and click. 

• To zoom out, click the mouse a second time. 

 To print the document: 
Mouse 
• From the Print preview toolbar click the print button.  You will 

see an icon appear on the status bar showing a working printer 
indicating that your file is being dispatched to the printer. 
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Edit from the Print preview screen 
Print preview is generally used to view how the document will look when it is printed.  
However, because you may spot mistakes that you want to correct as you are viewing the 
document Word has built in the ability to edit from within the Print preview. 

 To edit a document in Print preview: 
Mouse 
• In the Print preview window, move to the page that you want to 

edit. 

• Click the Magnifier button from the toolbar.  This will change 
your mouse pointer from a magnifying glass into an “I” beam. 

• Click the “I” beam to anchor the cursor where you want to make 
the changes. 

• When you have finished editing, switch the Magnifier back on by 
clicking the button once again. 

Pages per screen 
You can preview your document page by page in the Print preview screen or you can see 
several pages at once. 

 Change the number of pages viewed: 
Mouse 
• From the Print preview screen, click the Multiple pages button.  

• Drag your mouse over the grid to select the number of pages you 
want to see.  When you release the mouse, your Print Preview 
screen will change to reflect your choice. 

Or 
• Click the One page button to show only a single page in the Print 

preview. 
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Zoom 
Word will automatically scale your document to fit in the preview screen depending on 
how many pages you selected to view.  You can change the scale with the Zoom drop 
down list which offers you different percentages.  Choosing Page Width would ensure 
that the width of the page fits in to the preview screen, whereas Whole page would fit 
both the width and the height.  Two pages would show consecutive pages side by side. 

 To change the Zoom: 
Mouse 
• From the Print preview screen, click the drop down 

list arrow to the right of the current zoom percentage 
box. 

• Select the required option by clicking it.  Word will 
change the preview according to your choice. 

View ruler 
The ruler is useful if you are editing in the Print preview screen as it allows you to change 
the position of tabs and indent markers.  However, it does use up space so if you want to 
maximise the scale of the page within the preview window, you would have more room if 
you switched the ruler off. 

 To toggle the ruler on and off: 
Mouse 
• From the Print preview screen click the View ruler button to 

switch the ruler off. 

• Each time you click the button, the ruler will toggle on or off. 

Shrink to fit 
If only a small amount of text appears on the last page of a short document, you may be 
able to reduce the number of pages by clicking Shrink to Fit in print preview. This feature 
works best with documents that contain only a few pages, such as letters and memos. In 
order to shrink the document, Word decreases the font size of each font used in the 
document. 

 To shrink to fit: 
Mouse 
• From the print preview screen, click the Shrink to fit button.  

Note: You can undo a Shrink to Fit operation by clicking Undo Tools 
Shrink to Fit on the Edit menu. However, after you save the document and 
close it, there is no quick way to restore the original font size. 
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Full screen 
As a space saving option, you can fill the whole screen with a preview of your document, 
without sacrificing space to title bars and menus. 

 

 To preview full screen: 
Mouse 
• From the Print preview screen, click the Full screen button.   The 

title bar, menu bar and status bar will disappear to display a 

window like the one shown overleaf: 

 

Figure 51 - Full screen print preview 

• Click the Close Full Screen button when you want to return to the 
normal screen. 

Print a document 
You can print a document directly from whatever view you are using.  Word will send the 
document to your default printer. 
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 To print a document: 
Mouse 
• Click the print button from the standard toolbar 

Or 
Keyboard 
• Press [CTRL][P].  The Print dialog will appear; press [ENTER] to 

confirm the settings and launch the print.  Word will display the 
document printing icon on the status bar. 

 

Print part of a document 
The print button from the toolbar will always send one copy of the whole of the current 
document to the printer.  You may only need to print pages 1 and 2, or you may want to 
be even more specific and print just one paragraph.  To do any of these, you need to 
access the Print dialog. 

 To print a specific page or range of pages: 
Mouse 
• Choose File from the menu bar and then Print.   

Or 
Keyboard 
• Press [CTRL][P]. 

• The following dialog box will appear: 
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Figure 52 - Print dialog 

• In the Page Range section of the dialog, click the Pages option 
button.  A cursor will appear in the text box to the right. 

• Type in the page number that you want to print, or tell Word the 
range of pages (e.g. 1-6).  If your pages are not consecutive, you 
can enter them separated by commas (e.g. 1,10,13). 

• Click the OK button to launch the print. 
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 To print the current page:  
Mouse 
• Position the cursor somewhere on the page you want to print. 

 

• Choose File, Print to access the Print dialog. 

• Click the Current Page option button in the Page Range 
section of the dialog. 

• Click OK to launch the print. 

 To print the selection: 
Mouse 
• Select the text you want to print. 

• Choose File, Print to access the Print dialog. 

• Click the Selection option button in the Page Range section 
of the dialog. 

• Click OK to launch the print. 

Copies 
By default, Word will print one copy of the item you have sent to print.  You can print 
multiple copies by changing the Print dialog settings.  When you print multiple copies of 
a document, Word lets you choose whether the copies are collated (Word prints each 
whole document before it starts on the next copy) or uncollated (Word prints however 
many copies you have requested of each page). 

 

 To print multiple copies: 
Mouse 
• Choose File, Print to access the Print dialog.  
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• In the Copies section of the dialog, use the up and down arrows 
to the right of the Number of copies text box to set the number 
of copies you require. 

• Set the Collate check box by clicking in it to change the current 
setting. 

• Click OK to launch the print. 

Cancel a print 
If you accidentally send something to print and need to cancel it, you can do so by 
double-clicking on the document printing icon that appears on the status bar. 

 

Document printing 
icon 
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Section 8 

Tables 

By the end of this section you will be able to: 

 Insert a table 

 Enter and format text on tables 

 Navigate and select text 

 Change the table layout 

 Format tables 
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Tables 

Tables give you the ability to lay information out in columns and rows.  An example of a 
table is shown below: 

 

Item Action 
Word 2003 manual was discussed – 
deadline has now been set for end of next 
week. 

AM to complete manual and give a draft 
copy to HB for proof reading and 
revisions. 

 

Create tables 

When a table is created, Word will make the table as wide as the current page orientation 
allows.  Therefore, if you know your table is going to be quite wide, you may want to 
switch to landscape before creating it.  Your table is made up of rows and columns.  
Where the rows and columns intersect to form boxes, Word refers to those as cells. 

 

 To create a table: 
Mouse 
• Position the cursor where you want to insert the table. 

• Click the table button  on the toolbar.  

• Click and drag over the grid that appears to 
highlight the number of columns and rows that you 
want your table to have. 

• Release the mouse.  The table will appear in your document at the 
cursor position. 

• Enter text into your table. 
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Or 
Menu 
• Position the cursor where you want to insert the table. 

• On the Table menu, point to Insert, and then click Table.  

 

• Under Table size, select the number of columns and rows.  

• Under AutoFit behavior, choose options to adjust table size.  

• To use a built-in table format, click AutoFormat. 

• Click OK.  

• Enter text into your table. 

Note: You can add new rows in by pressing [TAB] when the cursor is in 
the last cell if you don’t know precisely how many rows your table will 
have. 
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Table Navigation 

When you are entering data into your table, you can simply click into different cells with 
your mouse to move your cursor around. This will allow you to enter text into different 
cells.  

However, you may find it faster to move around using the keyboard. The table below 
outlines some keyboard techniques for moving in a table: 

 

To Press 

Move to the next cell [TAB] (If the insertion point is in the last cell of 
a table, pressing TAB adds a new row.) 

Move to the preceding cell [SHIFT][TAB] 

Move to the preceding or next 
row 

[ ] or [ ] 

Move to the first cell in the row [ALT][HOME], or [ALT][7] on the numeric 
keypad (NUM LOCK must be off.) 

Move to the last cell in the row [ALT][END], or [ALT][1] on the numeric 
keypad (NUM LOCK must be off.) 

Move to the first cell in the 
column 

[ALT][PAGE UP], or [ALT][9] on the numeric 
keypad (NUM LOCK must be off.) 

Move to the last cell in the 
column 

[ALT][PAGE DOWN], or [ALT][3] on the 
numeric keypad (NUM LOCK must be off.) 

Start a new paragraph [ENTER] 

Add a new row at the bottom of 
the table 

[TAB] at the end of the last row 

Add text before a table at the 
beginning of a document 

[ENTER] at the beginning of the first cell 

Figure 53 - Table Navigation 

Enter data in a table 

You can enter text into each cell in your table – your text can even run to multiple lines 
within one cell. 

 To enter data in a table: 
Keyboard 
• Position the cursor in the cell where you want the information, 

and type it in. 
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• Press [ENTER] to start a new line within the same cell 

Or 
• Press [TAB] to move to the next cell. 

Select items in a table 

The table below outlines some methods for selecting table components: 

Mouse 
To  Do this 

Select a cell Click the left edge of the cell.  

Select a row Click to the left of the row. 

Select a column Click the column's top gridline or 
border. 

Select multiple cells, rows, or 
columns 

Drag across the cell, row, or 
column; or select a single cell, 
row, or column, and then hold 
down [SHIFT] while you click 
another cell, row, or column. 

Select text in the next cell Press [TAB] 

Select text in the previous cell Press [SHIFT][TAB] 

Figure 54 - Select in a table using the mouse 
 

Keyboard 
To Press 

Select the next cell's 
contents 

[TAB] 

Select the preceding cell's 
contents 

[SHIFT][TAB] 

Extend a selection to 
adjacent cells 

Hold down [SHIFT] and press an arrow 
key repeatedly 
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Select a column Click in the column's top or bottom cell. 
Hold down [SHIFT] and press [ ] or 
[ ] repeatedly 

Extend a selection (or 
block) 

[CTRL][SHIFT][F8], and then use the 
arrow keys; press [ESC] to cancel 
selection mode 

Reduce the selection size [SHIFT][F8] 

Select an entire table [ALT][5] on the numeric keypad (with 
NUM LOCK off) 

Figure 55 - Select in a table using the keyboard 

 

Note: You can also select rows, columns, or the entire table by clicking in 
the table and then using the Select commands on the Table menu. 

Format table data 

You can apply the same character and paragraph formats to table data as to standard text. 

 To format data in a table: 
Mouse 
• Select the data to format. 

• Click the button to apply the format from the formatting toolbar or 
choose Format, Font/Paragraph to select other formats. 

Note: Word treats each cell in a table as a separate paragraph.  This 
means that when you use alignment options for example, the data lines up 
between the edges of the cell according to the selected alignment. 

Change column widths 

The initial width of the columns of your table will depend upon the page orientation and 
how many columns you selected.  The standard widths that Word applies can be easily 
altered. 

 To change column widths: 
Mouse 
• Ensure that nothing in your table is highlighted (click away from 

any highlighting to remove it). 

• Move the mouse over the right edge of the column whose width 
you want to change – the mouse pointer will change shape (see 
below). 
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• Click and drag the column edge to make the column wider or 
narrower as required.  A vertical guide appears as soon as you 

start dragging allowing you to preview the new position of the 
column edge and its width. 

• Release the mouse.  The column will “jump” to its new width. 

Add rows and columns 

A new row can be added to the bottom of a table by pressing the tab key when the cursor 
is in the last cell.  If you need to, you can choose where new rows and columns should be 
inserted or deleted from your table and add or remove them accordingly.   

 To add a row: 
Menu 
• Select the row above or below where you want to insert the new 

row. 

• Select the Table, Insert, Rows Above or Rows Below commands. 

 To add a column: 
Mouse 
• Select the column to the left or right of where you want to insert 

the new one. 

• Select the Table, Insert, Columns to the Left or Columns to the 
Right commands. 

 To add several rows: 
Mouse 
• Highlight the number of rows you want to insert on the table  

• Select the Table, Insert, Rows Above or Rows Below commands. 

 To add several columns: 
Mouse 
• Highlight the number of columns you want to insert on the table. 
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• Select the Table, Insert, Columns to the Left or Columns to the 
Right commands. 

Remove rows and columns 

You can delete selected rows and columns from your table if they are no longer needed. 

 

 To remove rows: 
Menu 
• Select the rows that you want to delete. 

• Select the Table, Delete, Rows command. 

 To remove columns: 
Menu 
• Select the columns you want to delete. 

• Select the Table, Delete, Columns command. 
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Table borders and shading 

When you insert a table, Word automatically borders the outline and all the gridlines 
within – these will appear on a print out.  You may want to change the border style and 
colour or even remove the borders altogether.  You can also shade in parts of your table to 
emphasise them. 

Tables and Borders Toolbar 
 

Word has a whole toolbar devoted to formatting tables and their borders. 

 

 To access the Tables and Borders Toolbar: 
Mouse 
• Position the mouse over an existing toolbar and click the right 

mouse button. 

• From the resulting shortcut menu click Tables and Borders. 

Choose bordered edges 
 

You can decide which borders should appear in parts of the table, or in the table as a 
whole. 

 To choose the bordered edges: 
Mouse 
• Select the cell(s), row(s) or column(s) where you want to change 

which edges are bordered, or select the whole table. 

• Click the drop down arrow on the right of the Border button on 
the Tables and Borders toolbar. 

• From the palette that displays, click the button 
that displays the required option to control 
which edges of the selection will have borders 
and which will not. 
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Change border style 
You can change the line style, thickness and colour that Word uses to border the elements 
that make up your table.   

Line style 
You can choose between 22 different line styles to apply to the selection. 

 To change the line style: 
Mouse 
• Select the cell(s), row(s) or column(s) whose 

border style you want to change or select the 
whole table if you want to change all the borders. 

• Click the drop down arrow to the right of the 
Line Style list box on the Tables and Borders 
toolbar to display a list of line styles. 

• Click on the required style to apply it to your 
selection. 

Change the line weight 
Word has different options to control the thickness of the lines used to border tables. 

 To change line weight: 
Mouse 
• Select the cell(s), row(s) or column(s) 

whose border weight you want to change 
or select the whole table if you want to 
change all the borders. 

• Click the drop down arrow to the right of the Line Weight list 
box on the Tables and Borders toolbar to display a list of different 
line thicknesses. 

• Click the required option to apply it to your selection. 
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Change border colour 
You can pick between a variety of different colours for the lines that make up the table 
borders.  The colour will only show on a printout if you have a colour printer. 

 To change the border colour: 
Mouse 
• Select the cell(s), row(s) or column(s) whose 

border colour you want to change or select the 
whole table if you want to change colours for 
all the borders. 

• Click the Border colour button on the Tables 
and Borders toolbar to display a list of different colours. 

• Click the required colour to apply it to your selection. 

 

Table shading 

You can apply shading to tables using an option on the Tables and Borders toolbar. 

 To apply shading: 
Mouse 
• Select the cell(s), row(s) or column(s) where 

you want to apply shading or select the 
whole table if you want to shade the whole 
table. 

• Click the drop down arrow to the right of the 
Shading color button  on the Tables and 
Borders toolbar to display a list of different 
colours. 

• Click the required colour to apply it to your 
selection. 

Note: You can remove shading by selecting the items that are shaded, 
clicking the Shading Color button and choosing the None option 
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Repeating Table Headings 

When a table spreads across more than one page, it can be useful to automatically repeat 
the first row(s) of the table on each page as the first row(s) will often contain headings 
that apply to the columns of the table. If you choose to repeat table headings, the rows 
you have chosen will automatically be inserted at the top of each new page the table 
spreads onto. To edit the heading rows or make formatting changes, you must go back to 
the top of the table as it is simply an image of the first row(s) on the other table pages.  

 

 To repeat table headings: 
Mouse 
• Select the rows that you want to repeat at the top of each page the 

table prints on. 

• Choose Table from the menu bar and click the Heading row 
repeat option. 

You will only see the repeating headings when you are in Print Layout or 
Print preview. 
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Section 9 

Proofing Tools 

Objectives: 
By the end of this session you will be able to: 

 Spell check documents 

 Grammar check documents 

 Use Thesaurus 
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Spell Checker & Thesaurus 

The proofing tools in Word are very useful in ensuring that the documents you print and 
distribute are as error-free as possible.  

Word 2003 automatically checks spelling and grammar as you type provided the options 
have been set in the Options dialog box.  Spelling mistakes are flagged by a wavy red line 
under the error whilst grammatical faults show with a wavy green line. You can correct 
these mistakes as they are flagged by moving the mouse over the error and clicking the 
right mouse button – a shortcut menu will appear offering suggestions. 

 

 To correct a flagged mistake: 
Mouse 
• Click the right mouse button over the flagged mistake (e.g. a 

miss-spelt word). 

• Click on a suggestion from the top section of the short cut menu 
to replace the flagged word or phrase with the one offered by the 
spell/grammar checker.   

Or 
• Choose Ignore All to prevent Word from flagging any other 

occurrences of the word or phrase (useful with proper nouns, 
peoples’ names etc.) within the current document.   

Or 
• Select Add to add a copy of the flagged item to your custom 

dictionary – this will ensure that the word/phrase remains 
unflagged when you use it in the future.   

The AutoCorrect option gives another sub-menu of words pulled from the 
AutoCorrect list – these are generally the same as the suggestions at the top of the 
menu.  Finally, click the Spelling option to launch the spell check enabling you to 
work through the whole document and correct any mistakes. 

Launch the spell/grammar checker 

You can check the spelling and grammar of your document in one go by launching the 
spell/grammar checker.  There are several ways you can do this, but as Word will start 
checking from wherever your cursor is down the document; it makes sense to first move 
the cursor to the very beginning (use [CTRL][HOME]) before you commence the check). 
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 To launch the spell/grammar checker: 
Mouse  

• Click the Spelling and Grammar button  from the standard 
toolbar. 

 

• Word will launch the Spelling and Grammar dialog shown below: 

 

Figure 56 - Spelling & Grammar dialog 

The “error” shows in red in the box marked Not in Dictionary while any suggestions 
are listed in the box below.  Down the right-hand side of the dialog are a series of buttons 
allowing you to carry out different commands and these are described below: 

 

 To ignore the mistake: 
Mouse 
• Click Ignore to ignore the highlighted word and move on to the 

next item. 

Or 
• Click Ignore All to ignore all occurrences of the highlighted item 

throughout the current document and move to the next item. 
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 To add a word to the custom dictionary: 
Mouse 
• Clicking Add appends the highlighted word to your custom 

dictionary, ensuring that it will never be flagged as an error again.  
The spell/grammar check will move on to the next item. 

 To change the mistake: 
Mouse 
• Select the suggestion you want to replace the highlighted item 

with by clicking it with the mouse.   

• Click the Change button, to substitute the suggestion for the 
flagged word and move you to the next item. 

Or 
• If you have made the same mistake throughout a document, when 

the spell/grammar check hits the first one you can correct them all 
by clicking the Change All button.  The check will move on to the 
next item. 

 To use Autocorrect: 
Mouse 
• Click AutoCorrect to allow Word to make a decision about the 

error for you using its AutoCorrect feature (described later in this 
manual).   

 To undo a command: 
Mouse 
• If you don’t like the replacement you can click the Undo button 

which will become available at the bottom of the dialog to go 
back one step.  

 To alter options: 
Mouse 
• To alter any Spell/Grammar checker settings, click the Options 

button.  The following dialog box will appear: 
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Figure 57 - Spell/Grammar checker options 
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• You can enable or disable an option by checking or unchecking its 
box.  Click OK to save the new settings and return to the 
spell/grammar check. 

End the check 
When Word can find no further errors it will display the following dialog box: 

 
• Click OK to complete the check. 

Keyboard 
• You can launch the spell/grammar check using the keyboard by 

pressing F7. 

Word displays fewer buttons in the Spelling & Grammar dialog box if it is 
checking a grammatical error and you will see a Next Sentence button 
which you can use to move to the next item. 

Check item by item 
You can make use of this feature if Auto spell or grammar is enabled. 

 To check item by item:  
Mouse 
• Double-click the book icon on the status bar – Word will highlight 

the first “mistake” and offer you a shortcut menu of alternatives.  

• Pick your choice from the menu. 

• Double-click the book icon again to move to the next error. 

Pausing the Spell/Grammar check 
When a check is launched, you can see the highlighted items that Word considers to be 
errors behind the dialog box that it supplies to correct them.  If none of the options in the 
dialog box are suitable you can follow the instructions below to make changes. 
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 To pause the spell/grammar checker: 
Mouse 
• Click outside the box, in the document itself and make manual 

corrections.  This will pause the spell/grammar check (the dialog 
box options will appear “dimmed”).  

• Once you have finished editing, click the Resume button to 
reactivate the spell/grammar check. 

Disable/enable Auto Spell and Grammar Check 
 

Word 2003 settings are found under the Tools menu, within Options.  The dialog box that 
appears has multiple tabs, which aim to group options of a similar type. 

   

 To disable the automatic spell/grammar check: 
Menu 
• Choose Tools from the menu bar and click on Options. 

• Choose the tab marked Spelling and Grammar  

• Click the check boxes marked Check spelling as you type 
and Check grammar as you type so that the tick disappears. 

 To switch back on: 
Menu 
• Simply follow the instructions above but click the check boxes so 

that the tick reappears. 

When disabled the spell checker and grammar checker can be run manually whenever 
you wish by clicking the Spelling and Grammar button  . 

Thesaurus 

Word’s Thesaurus can be used to look up alternatives to words you have typed in a 
document.  Whilst it mainly helps to find synonyms to words, in some instances it will 
also look up antonyms.  You can then click buttons in the dialog box to replace the looked 
up word with your chosen synonym. 
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 To launch the Thesaurus: 
Menu 
• Select the word you want to look up. 

• Choose Tools from the menu bar, click Language and then 
Thesaurus from the sub-menu. 

• The Thesaurus task pane is shown below: 

 

Figure 58 - Thesaurus dialog 

The Looked Up drop-down list houses the word you selected before launching the 
thesaurus.  The Meanings list allows you to select in which context the looked up word 
should be placed.  Finally, a list of synonyms is displayed on the right.  The most likely 
choice is displayed in the Replace with Synonym text box. 

Choosing a meaning: 
If the synonyms offered don’t match the context in which you are using the word you are 
looking up, you can select a different meaning. 
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 To choose a meaning: 
Mouse 
• Click the most appropriate word from the Meanings list with the 

mouse.  The synonym list should change to offer you alternative 
options in the correct context. 

• Click the synonym you want to substitute for the looked up word, 
then click the Replace button.  The dialog box will close and the 
synonym will appear in your document. 

Look up a synonym 
If the synonyms Word initially offers are not comprehensive enough, you can look up 
further synonyms. 

 To look up synonyms: 
Mouse 
• Double-click a synonym from the synonym list – it will then 

become the looked up word with its synonyms being displayed on 
the right.   

• You can click the Previous button to move back one by one 
through the words that you have already looked up, or you can go 
back to a specific word by clicking the drop-down list arrow to the 
right of the looked up word.  This will display any item looked up 
since you launched the thesaurus. 

Keyboard 
• Select the word you want to look up. 

• Press [SHIFT][F7]. 
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.Notes 
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Section 10 

Page Layout 

Objectives: 
By the end of this session you will be able to: 

 Insert page breaks 

 Change margins and page orientation 

 Create headers and footers 

 Number pages 
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Page Setup 

There are some settings that apply themselves to documents as a whole rather than just 
the selected portions.  These include margins, paper size and orientation and some others.  
To change any of these settings, you use the Page Setup dialog.   

Page Setup dialog 

 To access the Page Setup dialog: 
Mouse 
• To access the dialog, choose File, Page Setup – the following 

dialog box will appear: 

 
Figure 46 - Page Setup dialog 

 

There are three tabs within the dialog box, each relating to a different page setting. 
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Margins Tab 
The margin measurements control the amount of white space that shows around the four 
edges of your page.   

 To change Margins: 
Mouse 
• Click the up and down arrows in the boxes labelled Top, 

Bottom, Left and Right to increase and decrease the margin 
measurements.   

• The Preview represents a printed page and will alter to show you 
what the new margins will look like. 

Gutter 
When a document needs to be bound, you can reserve the amount of space needed for the 
binding by setting the gutter measurement.  This will ensure that the binding will not 
“eat” into the left margin (the left margin measurement is unaffected by the gutter).   

 

 To set a gutter: 
Mouse 
• Click the up and down arrows in the Gutter box to change the 

gutter settings – the preview will show you the effects of your 
new settings. 

Orientation 

 To change the orientation: 
Mouse 
• Click the option button for either Portrait or Landscape.  

Portrait is the default orientation.  The Preview will show you 
what the page will look like if you confirm the settings. 
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Paper Tab 
This tab contains settings to control the size and print options for your pages. 

 

 
Figure 47 - Paper size tab 

Paper Size 

 To change paper size: 
Mouse 
• Click the Paper Size drop-down list to pick out the standard 

paper size or envelope size that you want to print the document 
on.   

• If you are printing on a piece of paper of a non-standard size, you 
can choose the Custom size option and then use the Width and 
Height boxes below to set the exact of your page.  The Preview 
will display the chosen size. 
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Paper Source 
With a document that runs to several pages, you may need to specify that the first page 
should be printed on headed paper, while the other pages should be printed on normal 
blank sheets.   

 To set the Paper Source: 
Mouse 
• Click the tray in the First page list that you want to print the first 

page of your document on. 

• Click the tray in the Other pages list that you want to print all 
other pages of your document on. 

You can also specify manual feed when the paper you wish to use is not 
pre-loaded.  This will allow you to load paper into the printer and then 
press the On-line button to commence printing. 
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Layout Tab 
This tab contains settings that relate primarily to sections within a document.  This topic 
is not discussed in this manual. However, you can use the layout tab to set various options 
relating to your headers and footers. 

 
 

Headers and Footers 
You can use these settings to determine how far from the edge of your page the header 
and footer will print.   

 Set the From edge amount: 
Mouse 
• Change the measurements by clicking the up and down arrows in 

the Header and Footer From edge boxes – a higher number 
will move the header or footer further away from the edge of your 
paper (i.e. further into your document), while 0 represents the 
edge of the paper.   

You won’t see these settings change on the page preview within the dialog, 
but you will notice in the views that display the header and footer. 



Word 2002 Essentials 

Page Layout 

© The Mouse Training Company Page 144 http://www.mousetraining.co.uk 

Page breaks 

Word knows how many lines will fit onto a page and so as you near the limit, it will insert 
an automatic page break.  This may appear as a dotted line across the screen or you may 
see it appear as a new sheet of paper – the view that you are using will determine how the 
break looks (see Section 7 – Viewing and Printing for more details on Views). 

Sometimes, the positions of the page breaks that Word inserts are not convenient or make 
the document look imbalanced.  You can put the page break in a different place by 
inserting it manually as described below: 

 To insert a page break: 
Menu 
• Position the cursor at the beginning of the line below where you 

want the page break. 

• Choose Insert from the menu bar and then Break.  A small dialog 
appears with different option buttons, the default selection being 
Page break. 

• Click OK 

Or 
Keyboard 
• Position the cursor at the beginning of the line below where you 

want the page break. 

• Press [CTRL][ENTER]. 

To remove a manual page break 

If you need to remove a manual page break, it is best to switch to Normal view (see 
Section 7 – Viewing and Printing for more details on how to access this view).  You will 
see the page break represented as a dense dotted line with the word Page Break on it.   

 To remove a manual page break 
Keyboard 
• Position the cursor on the page break line and tap the [DELETE] 

key on the keyboard – the page break will disappear. 
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Headers and Footers 

Headers and footers are used for items that you want to appear on every page of your 
document.  The header appears in the top margin and the footer in the bottom margin.  
Examples of the types of things you might want as your header would include, a logo the 
current file name or the current date and time.  The most common footer item is page 
numbers. 

When you are adding header or footer items, Word automatically sets the view to Print 
Layout as this is the only view where you can see the header and footer area.  While you 
are in the header or footer, the rest of the document appears dimmed to show that it is 
currently unavailable for editing.  As soon as you close the header or footer, your 
document comes back “online”. 

Header and footer toolbar 

Word supplies a special toolbar when you are creating headers and footers.  It contains 
buttons you can click to quickly insert dates, times and page numbers and also allows you 
to switch quickly between the header and the footer areas. 

 

 To create headers and footers: 
Mouse 
• Choose View from the menu bar and click the Headers and 

Footers option.  The screen will change to show the header section 
enclosed in a bounding box.  The Headers and Footers toolbar will 
also be displayed (see overleaf). 

 

• Within the header section, enter the items that you want to appear 
at the top of each page.  Word has pre-set tabs that you can use to 
place items at the centre and right hand side of the page; simply 
press the tab key to move the cursor to these positions. 

• Format the items as you would document text. 
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• If you want to set up a footer, click the Switch between header 
and footer button – Word will display the footer section which 
also contains pre-set centre and right tabs. 

• Enter the items to appear at the bottom of each page in the footer. 

• When you have finished, click the Close button from the Headers 
and Footers toolbar. 

Insert Header and Footer field codes 

The Headers and Footers toolbar has some buttons that you can use to place the current 
date or time, or the page number and total number of pages in the header or footer.  The 
buttons insert these items as field codes.  Field codes are pieces of program code that give 
Word an instruction to do something in the document at the point they have been inserted.  
The main reason they are so useful to use is that they will update automatically every time 
the document is saved or printed.  So for example, if you were printing a daily time sheet, 
you could insert a date field in the header which would always return the current date, 
regardless of when you print it out.  

 

 

 To use header and footer codes: 
Mouse 
• Choose View from the menu bar and then click Header and footer.  

Switch to the section (i.e. header or footer) where you want to use 
the code. 

• Position the cursor where you want the information. 

• Click the relevant button from the Headers and Footers 
toolbar. 

• Click the Close button to close the header and footer. 

Field codes display grey shading when you click on them.  You can delete 
them by dragging over them with the mouse to select them and pressing 
the [DELETE] key. 

Page 
number 

Total 
number 
of 
pages 

Format page 
number 

Current date Current time
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Using pictures in headers and footers 

If you need a picture to appear on every page of your document, you can put it in the 
header or footer.  Because pictures are graphics, they aren’t confined to the margin areas 
like text in headers or footers, so you can place them on the middle of the page if you 
like.  This can be very useful for company logos. 

 

 To insert a picture as a header/footer: 
Mouse 
• Choose View from the menu bar and then click Header and 

footer.  Switch to the section (i.e. header or footer) where you 
want to the picture. 

• Click the Show/Hide document text button from the Headers 
and Footers toolbar. 

• Choose Insert from the menu bar, click Picture and choose the 
source of your picture from the sub-menu.  Select the item that 
you want to use and click OK to bring it into your document. 

• With the picture selected, you can format it by choosing Format 
from the menu bar then Picture.   

• The resulting dialog box allows you to set the picture up as a 
watermark by setting the Image Control on the Picture tab to 
Watermark.  You can also ensure that you can float text over the 
picture by setting Wrapping behind text .  When you have 
finished formatting, click OK. 

• Finally, drag the picture around the page until it is in the correct 
position.  Click Close  from the Header and Footer toolbar to 
close the header and footer. 

You won’t see the picture unless you are in Page Layout view or Print 
preview. 

 
Page numbers 

There are several ways that you can add page numbers to a document in Word.  The 
method you use depends on how you want the page numbers to appear.  If you want total 
control over where the page number sits and the word “Page” to appear next to the 
number, you would use headers and footers to set it up.  If you want a number in a 
standard position at the top or bottom of each page, you can use the Page Numbers 
option on the Insert menu described below. 
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 To add page numbers to a document: 
Mouse 
• Choose Insert from the menu bar and click Page Numbers.  

The following dialog box will appear. 

 

Figure 49 - Page Numbers dialog 

• Click OK to insert the page numbers in the bottom right-hand 
corner of each page. 

As the page numbers are added in the header or footer area of each page, 
you will only see them if you are using Page Layout view to edit your 
document.  Print preview will also display the page numbers.  See Section 
2 – Viewing and Entering Information for more details. 
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Position 
The default position for page numbers inserted as described above is at the bottom of the 
page.  You can choose to put your page numbers at the top of each page. 

 

 Change page number position: 
Mouse 
• Choose Insert from the menu bar and click Page Numbers.   

• Click the drop down list arrow to the right of the Position list 
box. 

• Choose the position for the page numbers and click OK. 

If you already had page numbers positioned at the bottom of each page, 
the above steps would give you a second set of page numbers at the top of 
each page.  You can delete them by accessing the header or footer (see the 
next section for more information). 

Alignment 
Page numbers can be place on the right or left-hand sides of the page, or centred between 
the left and right margins. 

 

 To change page number alignment: 
Mouse 
• Choose Insert from the menu bar and click Page Numbers.   

• Click the drop down list arrow to the right of the Alignment list 
box. 

• Choose the alignment for the page numbers and click OK. 

Format 
Word will automatically number your pages with Arabic numbers (1,2,3 etc.).  You can 
choose to change to different numbering styles using the Format button. 

 To change the page number format: 
Mouse 
• Choose Insert from the menu bar and click Page Numbers.   

• Click the Format button – the following dialog will appear: 
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Figure 50 - Page number format dialog 

• Click the drop down list arrow to the right of the 
Number format list box and choose the desired number style. 

• Click OK to return to the Page numbers dialog. 

• Click OK to close the Page numbers dialog and update the 
number format used. 

Start number 
If your document is part of a report that is compiled of a number of separate files, you 
may need to choose at which number the page numbering should start.  Word will begin 
at 1 unless you tell it otherwise. 

 To change the start number: 
Mouse 
• Choose Insert from the menu bar and click Page Numbers.   

• Click the Format button. 

• Click the option button Start At.  Word will display number 1 in 
the text box to the right. 

• Click the up and down arrows in the box where the start number is 
displayed to increase or decrease the number at which page 
numbering should begin. 

• Click OK to return to the page numbers dialog and OK again to 
update the page number settings. 



Word 2002 Essentials 

Page Layout 

http://www.mousetraining.co.uk Page151 © The Mouse Training Company 
   

Suppress page numbers 
Word gives you an option not to print a number on the first page of your document.  This 
may be useful if you have included a title page at the beginning of your file where you 
don’t want a number. 

 To suppress numbers on the first page: 
Mouse 
• Choose Insert from the menu bar and click Page Numbers.   

• Uncheck the box marked Show number on first page. 

• Click OK to save the settings and close the dialog box. 
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Appendix One 

Keyboard Shortcuts 
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Movement keys 

[ ] Move the cursor one character to the right 

[ ] Move the cursor one character to the left 

[ ] Move the cursor up one  line

[ ] Move the cursor down one line

[CTRL][ ] Move the cursor right one word at a time 

[CTRL][ ] Move the cursor left one word at a time

[CTRL][ ] Move the cursor up one paragraph at a time 

[CTRL][ ] Move the cursor down one paragraph at a time 

[HOME] Move the cursor to the beginning of the current line 

 [END] Move the cursor to the end of the current line 

[PAGE UP] Move up a screenful of lines

[PAGE DOWN] Move down a screenful of lines

[CTRL][HOME] Move to the beginning of the document

[CTRL][END] Move to the end of the document
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Selection keys 

Action Result 

[SHIFT][ ] Select one character to the left 

[SHIFT][ ] Select from the cursor up one line 

[SHIFT][ ] Select from the cursor down one line 

[SHIFT][CTRL][ ] Select right word by word  

[SHIFT][CTRL][ ] Select left word by word 

[SHIFT][CTRL][ ] Select up one paragraph at a time 

[SHIFT][CTRL][ ] Select down one paragraph at a time 

[SHIFT][HOME] Select from the cursor to the beginning of the 
current line 

[SHIFT][END] Select from the cursor to the end of the 
current line 

[SHIFT][CTRL][HOME] Select to the beginning of the document 

[SHIFT][CTRL][END] Select to the end of the document 

[CTRL][A] Select the entire document 
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Keyboard shortcuts for character 
formatting 

Increase the font size [CTRL][SHIFT][>] 

Decrease the font size [CTRL][SHIFT][<] 

Increase the font size by 1 point [CTRL] ] 

Decrease the font size by 1 point [CTRL] [ 

Display the Format, Font dialog [CTRL][D] 

Change the case of letters [SHIFT][F3] 

Format letters as all capitals  [CTRL][SHIFT][A] 

Apply bold formatting [CTRL][B] 

Apply an underline  [CTRL][U] 

Underline words but not spaces [CTRL][SHIFT][W] 

Double-underline text [CTRL][SHIFT][D] 

Apply hidden text formatting [CTRL][SHIFT][H] 

Apply italic formatting [CTRL][I] 

Format letters as small capitals  [CTRL][SHIFT][K] 

Apply subscript formatting (automatic 
spacing) 

[CTRL][=] 

Apply superscript formatting (automatic 
spacing) 

[CTRL][SHIFT][+] 

Remove manual character formatting [CTRL][SPACEBAR] 



Word 2002 Essentials 

Keyboard Shortcuts 

© The Mouse Training Company Page 156 http://www.mousetraining.co.uk 

Keyboard shortcuts for paragraph 
formatting 

Single-space lines [CTRL][1] 

Double-space lines [CTRL][2] 

Set 1.5-line spacing [CTRL][5] 

Add or remove one line space 
preceding a paragraph 

[CTRL][0] 

Centre a paragraph [CTRL][E] 

Justify a paragraph [CTRL][J] 

Left align a paragraph [CTRL][L] 

Right align a paragraph [CTRL][R] 

Indent a paragraph from the left [CTRL][M] 

Remove a paragraph indent from the 
left 

[CTRL][SHIFT][M] 

Create a hanging indent [CTRL][T] 

Reduce a hanging indent [CTRL][SHIFT][T] 

Remove paragraph formatting [CTRL][Q] 
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Shortcuts keys for table navigation 

To Press 

Move to the next cell [TAB] (If the insertion point is in the last cell of 
a table, pressing TAB adds a new row.) 

Move to the preceding cell [SHIFT][TAB] 

Move to the preceding or next 
row 

[ ] or [ ] 

Move to the first cell in the row [ALT][HOME], or [ALT][7] on the numeric 
keypad (NUM LOCK must be off.) 

Move to the last cell in the row [ALT][END], or [ALT][1] on the numeric 
keypad (NUM LOCK must be off.) 

Move to the first cell in the 
column 

[ALT][PAGE UP], or [ALT][9] on the numeric 
keypad (NUM LOCK must be off.) 

Move to the last cell in the 
column 

[ALT][PAGE DOWN], or [ALT][3] on the 
numeric keypad (NUM LOCK must be off.) 

Start a new paragraph [ENTER] 

Add a new row at the bottom of 
the table 

[TAB] at the end of the last row 

Add text before a table at the 
beginning of a document 

[ENTER] at the beginning of the first cell 
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Shortcut keys for selecting in a 
table 

To Press 

Select the next cell's 
contents 

[TAB] 

Select the preceding cell's 
contents 

[SHIFT][TAB] 

Extend a selection to 
adjacent cells 

Hold down [SHIFT] and press an arrow 
key repeatedly 

Select a column Click in the column's top or bottom cell. 
Hold down [SHIFT] and press [ ] or 
[ ] repeatedly 

Extend a selection (or 
block) 

[CTRL][SHIFT][F8], and then use the 
arrow keys; press [ESC] to cancel 
selection mode 

Reduce the selection size [SHIFT][F8] 

Select an entire table [ALT][5] on the numeric keypad (with 
NUM LOCK off) 
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